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Preface

The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation
folder available on your network from which you can access the Oracle|Agile documentation (PDF)
files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later.
This program can be downloaded from the Adobe Web site (http://www.adobe.com).

The Oracle Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help >
Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or
information, please contact support (http://www.oracle.com/agile/support.html)
(http://www.oracle.com/agile/support.html) for assistance.

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please
have the full part number, which is located on the title page.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible, with good
usability, to the disabled community. To that end, our documentation includes features that make
information available to users of assistive technology. This documentation is available in HTML
format, and contains markup to facilitate access by the disabled community. Accessibility standards
will continue to evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be accessible to
all of our customers. For more information, visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html)
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Agile Training Aids

Go to the Oracle University Web page
(http://www.oracle.com/education/chooser/selectcountry _new.html) for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Installation Checklists

This chapter includes the following:

= Pre-InStallation CRECKIIS .........c..cviririireese e 1
= Application Server Installation ChECKIISE...........coieuriiiriirriesee s 2
= Clustered Application Server Installation ChECKIISt ..o s 2
= File Manager INStallation ChECKIISE...........c.oviirieiricirei et

Web Proxy Server Installation Checklist

Pre-Installation Checklist

Before installing the Agile PLM software, you need to log in to your machine with local Administrator
privileges and check the following:

O Can you ping all servers, including the database server, on which you plan to install Agile PLM
components? For example, try pinging the database server from the application server.

O Have you verified the Domain Name System (DNS) host name of each server on which you plan to install
Agile PLM components? In DNS, the fully qualified domain name consists of the hostname, then a period,
then the domain name.

Note When you are prompted by the Agile PLM installer to enter a host name, enter the
fully qualified domain name of the server.

O If you are installing an application server cluster, have you ensured that all application servers and the
load balancer are registered in the same domain?

O Is your Agile PLM database server installed and running?
O Is BEA WebLogic 8.1 SP6 installed on the machine where you are installing the Agile Application Server?

O Have you verified that you have read, write, and execute permissions for the computer on which you want
to install Agile PLM?

Additionally, if you are upgrading:
O Have you backed up the files on your File Manager server?

O Have you uninstalled the previous version of Agile PLM?

Note You must be able to complete this checklist before installing Agile PLM.

Agile Product Lifecycle Management Page - 1
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Application Server Installation Checklist

Follow these steps to install the Agile Application Server:
O Install BEA WebLogic 8.1 SP6.

See the BEA product documentation at http://e-docs.bea.com/wls/docs81/index.html (http://e-
docs.hea.com/wls/docs81/index.html) for installation instructions.

O Install the Agile PLM Application Server component.
Make sure you select Advanced Mode during installation.

See “Installing Agile PLM (on page 11).”

O On Windows: Restart the machine.

O Verify that the Agile Application Server is working properly.
See “Testing the Agile Application Server Connection”.
O (Optional) Configure a Web proxy server for your Agile PLM system.

To install the BEA WebLogic plug-in and other files needed to use Microsoft Internet Information Services (I1S) as your Web
proxy server, install the Agile PLM Web Proxies component on your Web server. See “Installing Agile PLM. (see
"Installing Agile PLM" on page 11)”

To configure your Web proxy server, “Configuring a Web Proxy Server for Agile PLM. (see "Configuring a Web Proxy
Server for Agile PLM" on page 39)"

Clustered Application Server Installation Checklist

Follow these steps to install an Agile Application Server cluster:

O Install BEA WebLogic 8.1 SP6 on each server.

Important Make sure you install BEA WebLogic into the same directory structure on each server in the
cluster. Also, all servers in the cluster must use the same operating system. Otherwise, you will
be unable to deploy the Agile application to all servers in the cluster.

See “About Agile Application Server Clusters (on page 23)".

O Install the Agile PLM Application Server component on the administration server.
Make sure you select Advanced Mode during installation.

See “Installing Agile PLM (on page 11)."

O Install the Agile PLM Application Server component on the managed servers.

See “Installing Agile PLM. (see "Installing Agile PLM" on page 11)"

O Set up the cluster on the administration server.
See “Setting Up a WebLogic Cluster”.

O  Addthe managed servers to the cluster.
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O Verify that the Agile cluster is working properly.

See “Starting the Weblogic Administration Server (on page 24)".

O Configure a load balancer or a Web proxy server for your Agile PLM system.

For information about configuring a load balancer, see “Configuring the Load Balancer (on page 27)".

To install the BEA WebLogic plug-in and other files needed to use Microsoft Internet Information Services (IIS) as your Web
proxy server, install the Agile PLM Web Proxies component on your Web server. See “Installing Agile PLM. (see
"Installing Agile PLM" on page 11)"

To configure your Web proxy server, see “Configuring a Web Proxy Server for Agile PLM. (see "Configuring a Web
Proxy Server for Agile PLM" on page 39)"

File Manager Installation Checklist

Follow these steps to install the File Manager:
O If you are upgrading to Agile PLM from a release prior to Agile PLM 9.2, back up and reorganize your file vault.

See “Upgrading the File Vault”.

O Install the Agile PLM File Manager component.
See “Installing Agile PLM (on page 11)."

O Start the Agile Application Server.

O (Optional) Configure a Proxy Server for the File Manager.

See “Configuring IS as a Proxy Server for Agile File Manager” or “Configuring the Apache Web Server as a Proxy

Server for Agile PLM and Agile File Manager (on page 47)".

O Configure the File Manager.

See “Configuring the File Manager (on page 29)".

O Start the File Manager.
See “Starting the File Manager (on page 37)".

O Verify that the File Manager is working properly.

See “validating the File Manager Installation (on page 37).

Web Proxy Server Installation Checklist

Follow these steps to configure a Web proxy server in your company’s DMZ for the Agile
Application Server and Agile File Manager:

O Stop your Web server.

Page - 3



Installing Agile PLM for WebLogic

O Install the Agile PLM Web Proxies component.
See “Installing Agile PLM (on page 11)."

O Configure your Web server to be a proxy server for either the Agile Application Server, the Agile File Manager, or both.

See “Configuring a Web Proxy Server for Agile PLM. (see "Configuring a Web Proxy Server for Agile PLM" on page
39)"

O Test the connection by logging into the Agile Web Client.

See “Logging In to the Agile Web Client” .

Overview

Agile PLM 9.2.2.4 is a full install which can be distributed over a wide-area network with multiple
servers, or it can be limited to a single server with several client computers.

Important Before upgrading to Agile PLM 9.2.2.4, read through this entire chapter and the Readme
for the latest information. For information about optional upgrade services available from
Agile, contact Agile Technical Support.

Note All folder names and paths show the default settings provided during
installation. Your system structure may be different if folder names or paths
were changed during the Agile PLM installation.

Upgrading Agile Server Components

Before you upgrade any components, you should make sure that all components in the Agile
system work and communicate properly. Performing an upgrade on a system that is not functioning
correctly will compound troubleshooting techniques.

Important Refer to the Agile PLM Database Upgrade Guide for schema upgrade requirements.

System Requirements for Upgrading

Additional hard disk space may be required to upgrade to Agile PLM 9.2.2.4 efficiently. Before you
can install Agile server components, you must have at least 60 MB of available disk space available
where the OS is installed. It is also recommended that you have at least 100 MB of available disk
space for the upgrade.

Checking Available Disk Space and Tablespace Size

Be sure you have enough unused disk space available on the computer where the database is
installed before upgrading—at least 100 MB plus an amount equal to 100 percent of your current
database and at least twice the size of your user-data tablespace.
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Important Refer to the Agile PLM Database Upgrade Guide for tablespace requirements.

Backing Up Files

Note Agile PLM 9.2.2.4 is a full install and installs into a new default location. If you
accept this location, earlier Agile releases will not be overwritten.

Back up any existing ChangeCAST and other Agile-related folders to a safe location before
upgrading any component to Agile PLM 9.2.2.4.
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Chapter 2
Upgrading to Agile PLM 9.2.2.4

This chapter includes the following:

DiISADIING SEBIVICES ...v.vvvvrereirieesiseseieissesss st ese st eas e s s s s st es s e s s et e s s e st s s s s e
Upgrading RolES and PriVIIEIE MASKS ..........cceriruriireinieirireee sttt ssssessssssasessssesesnsseens
BaCKING UP the REQISIY ..vvevcieeeieieies ettt e
Upgrading the Database..........ccccccoeerireerineennn
Upgrading the Agile PLM 9.2.2.4 Application
UpQrading the File VAUIL ..........ccovieicrircs st s
Upgrading the Agile PLM ACHIVEX CONIOL.........cvevieurieesirircnssrsissserssssessssssssssssesssssssssssesssssssssssssessssssesessssens
Upgrading RolES and PriVIIEIE MASKS ..........ceririuriireniiiririee sttt ssssesssssssssssssesesnsseens

Important If you are performing a new installation, skip this chapter and continue to the Installing
Adgile PLM (on page 11) Chapter.

Disabling Services

To disable Agile services:

1. Ensure that all Agile services are stopped:
a. Choose Start > Settings > Control Panel.
b. double-click the Administrative Tools icon and then double-click the Services icon.

c. For each Agile service in the Services dialog box, select the service, right-click and
choose Stop in the shortcut menu. Also for each service, open the Properties dialog box
and change the Startup Type to Disabled.

d. You must also stop the IIS Admin service if it is running.
e. Close the Services dialog box.

2. Restart all servers in the Agile system.

Upgrading Roles and Privilege Masks

When you upgrade your Agile PLM database, any existing Agile PLM roles and privilege masks that
your company uses are not automatically updated to include new privileges and attributes. The
Agile PLM administrator must update existing roles and privilege masks manually using the Agile
Java Client.

Agile PLM includes a number of example roles that you can use to modify your own roles. They are
stored under the Examples node folder in Java Client. Example roles are read-only and cannot be
modified. However, you can use Save As to make a copy of an example role and modify the copy.
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Example roles include example privilege masks. When you use Save As to create a copy of an
example role, the system populates the new role with the privilege masks.

For more information on how to edit roles and privilege masks, see the Agile PLM Administrator
Guide.

Backing Up the Registry

The registry contains information created by the Agile installation program. You can backup registry
branches so that you can return your system to its previous state.

Note If you have disk space available, you can backup the entire registry (instead of
specific branches) before upgrading to Agile PLM 9.2.2.4.

To use regedit to backup registry branches:

1. Choose Start > Run.

2. Type regedit in the Open field of the Run dialog box.

The Registry window opens.

Expand the HKEY_LOCAL_MACHINE > Software tree and select the Agile registry branch.

W

Choose Registry > Export Registry File.
The Export Registry File dialog box appears.
5. Make sure the Agile branch appears in the Select Branch field.

6. Name the branch agilebranch, and save it to a secure location.

In the event you do not want to continue using this release of Agile PLM 9.2.2.4, you can import
these registry branches, and then restart the computer.

Upgrading the Database

The Agile database must be upgraded before installing the Agile Application Server. Refer to the
Agile PLM Database Upgrade Guide for details about the Automated Upgrade Tool provided with
Agile PLM 9.2.2.4.

Upgrading the Agile PLM 9.2.2.4 Application

Because it is a full install, you should uninstall your previous version of Agile PLM before installing
Agile PLM 9.2.2.4,

Important Do not install into the same folder used by the previous installation of Agile. Choose a new
installation location.
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Upgrading the File Vault

In Agile PLM, the file vault structure must be reorganized. In previous versions of Agile, files were
stored in the <iFS Root> or files directory. In the new design, files are stored in separate directories
based on a file ID. All existing files must be reorganized to conform to the new design
specifications. If you have an existing iFS or Distributed File Manager (DFM) configuration, you
must reorganize the files on each file server.

To reorganize existing files:

1. Back up any existing Agile file vaults to a safe location before upgrading any component to
Agile PLM 9.2.2.4. The default location for Agile iFS Files in Agile 8.5 is \\Program Files\Agile
Product Collaboration\iFS\Files.

If you have existing Distributed File Managers, you must also back up the files on all the DFMs.

2. After you have copied all files into a backup directory, install the new File Manager by following
the instructions in “Starting the Agile PLM Installer (on page 14)", if it is not already installed.

3. Copy any files that you backed up earlier into the File Manager Storage Location you specified
during the file manager installation.

Go to the AGILE_HOME\AgileDomain\Tools\ directory.
Run the iFSReorgV2 utility:

Usage: java -jar iFSReorgV2.jar -basedir <value> -oldFilePrefix <value> [-newFilePrefix <value>] [-
logging <true/false>] [-simulate <true/false>]

where
® basedir is the file vault location to be reorganized
* oldFilePrefix is the old file name prefix for the existing files in the vault

* newFilePrefix is the new file name prefix. All of the existing files will be renamed with this
prefix. This is an optional argument. If it is not specified, the old file name prefix is used.

* logging enables logging of warnings or errors if set to true. The log is saved to a file named
ifsReorg.log.

* simulate simulates the reorganization process without actually moving or renaming the files.
6. After the program completes, the reorganization summary information displays.

Go to “Configuring the File Manager (on page 29)" to configure the new file manager with the
upgraded vault information and to validate the installation was successful.

Upgrading the Agile PLM ActiveX Control

If you used the Microsoft Excel-based client to open Agile PLM 9.2 Declarations in Microsoft Excel,
you have the Agile PLM ActiveX Control (version 1.0.313.1) installed on your client computer. Agile
PLM 9.2.2.4 uses a later version (1.0313.8) of the Agile PLM ActiveX Control.

Optionally, you can uninstall the older Agile PLM ActiveX Control. If the Agile PLM preference Allow
Downloading of Productivity Components is set to Yes, the next time you use the Agile Web Client to
open a Declaration in Microsoft Excel, the latest version of the Agile PLM ActiveX Control will be
downloaded and installed automatically.
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Note Before uninstalling the Agile PLM ActiveX Control, close Microsoft Excel.

Upgrading Roles and Privilege Masks

When you upgrade your Agile PLM database, any existing Agile PLM roles and privilege masks that
your company uses are not automatically updated to include new privileges and attributes. The
Agile PLM administrator must update existing roles and privilege masks manually using the Agile
Java Client.

Agile PLM includes a number of example roles that you can use to modify your own roles. They are
stored under the Examples node folder in Java Client. Example roles are read-only and cannot be
modified. However, you can use Save As to make a copy of an example role and modify the copy.

Example roles include example privilege masks. When you use Save As to create a copy of an
example role, the system populates the new role with the privilege masks.

For more information on how to edit roles and privilege masks, see the Agile PLM Administrator
Guide.
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Installing Agile PLM

This chapter includes the following:

INSEAIALION PrOCESS ... .ottt ettt bbb
Agile PLM SYSIEM REGUIFEMENTS ....cvuvvreeeicrreriereesiseeseseseieeeeessesessssasessssssssss et sssssssssesesssssssssssesesssassesessssesassens
Obtaining Software from Oracle E-delivery
Copying the AGIlE PLIM FIES ..ottt bbb
Starting the Agle PLIM INSEAIIET ..........cciicii ettt nae s ssenas
Agile PLM COmMPONeNts.........ccoevreerrereenseenennns

Agile PLM INStAllAtion MOUES .....c.veveereiceeiiercisiseeis e sesssse s ssssesss s s s ssssssssss s sssssssssssesssnssessssssesasnens
Agile PLM Installation Folders ............cccoeneunne.

AQile PLIM WINAOWS SEIVICES .....viueeieieiiriieisieieis ettt ettt bbbttt

Installation Process

Agile PLM is designed to run optimally on multiple computers. This guide is presented with separate
chapters for certain Agile PLM components. To set up an Agile PLM system, you should install the
main components in the following order:
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Note If the Application Server, File Manager and Web Server components will be installed on
one machine, then they can be installed at the same time.

Agile Database Refer to the Agile PLM Database Installation Guide |

l

Agile Application This applies to both a standalone application server or
Server application server clusters.

l

Agile File
Manager

l

Agile Web
Proxies

Important If you are upgrading from a previous version of Agile PLM, first read " Upgrading to Agile
PLM 9.2.2.4 (on page 7)".

Agile PLM System Requirements

Agile PLM may be deployed in different configurations. The amount of time required to complete an
installation depends on the complexity of your Agile PLM implementation.
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Note Make sure you have installed all Windows updates, especially for the DirectX
component.

For installations using a certified localized language, all server components must be installed on
computers running the same localized OS. Clients can be running on the same localized OS or
English OS. For detailed information about using Agile PLM with international operating systems,
contact the Agile support Web site.

The general recommended configuration for Agile PLM components is one computer for each of the
following server components:

o Agile database
o Agile Application Server

Note Before installing Agile PLM 9.2.2.4, BEA WebLogic 8.1 SP6 must be installed
on the computer where you plan to install the Agile Application Server

It is acceptable to install multiple server components on the same computer if the additional
resources are not available. However, the minimum hardware requirements must be increased
based on the number of server components installed on a single computer. For specific hardware
and software requirements, see the Capacity Planning and Deployment Guide.

Network service and TCP/IP protocol must be enabled before you install Agile PLM.

On Windows, if you receive the error message “Failed to retrieve domain name from registry.
Please enter the domain name in the TCP/IP properties and try again later” and the installation
aborts, then you must setup Network service, as follows:

1. From the Control Panel window, double-click the Network and Dial-up icon.

2. right-click on the Local Area Connection icon and choose Enable from the shortcut menu.

Obtaining Software from Oracle E-delivery

Oracle products are distributed as Media Packs. A Media Pack is an electronic version of the
software. Refer to the Media Pack description or the list of products that you purchased on your
Oracle Ordering Document. Then, view the Quick Install Guide License List to help you decide
which Product Pack you need to select in order to search for the appropriate Media Pack(s) to
download. Prior to downloading, verify that the product you are looking for is in the License and
Options section of the E-Pack README. Oracle recommends that you print the README for
reference.

Please download each Product Pack from the Oracle E-Delivery web site
(http://edelivery.oracle.com/) as specified below.

1. Oracle Agile Product Lifecycle Management
2. Oracle Application Server (SOA Suite)

3. Oracle Database Server

There will be an itemized part list within each of the packs and you will need to download all items in
order to have the complete download for the desired Oracle Agile release.

All Oracle E-Delivery files have been archived using Info-ZIP's highly portable Zip utility. After
downloading one or more of the archives, you will need the UnZip utility or the WinZip utility to
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extract the files. You must unzip the archive on the platform for which it was intended. Verify that
the file size of your downloaded file matches the file size displayed on E-Delivery. Unzip each Zip
file to its own temporary directory.

Copying the Agile PLM Files

Before installing Agile PLM, the contents of the media packs should be copied to a local directory
with the same file structure used by the Installer. The Platforms directory must be copied into the
same directory as the setup file.

Note Be sure to check the size of the media packs after copying the files to verify
that all files have been copied.

Starting the Agile PLM Installer

Important Install and test this release on a designated test server before installing it on your
production environment. Your test environment should mirror your production environment
as closely as possible to provide accurate testing results. It is important to validate the
installation of this release and confirm your integrations are working correctly as part of
your minimum due diligence. Any problems or questions noted during your system testing
should be resolved before installing this release on your production environment.

The Agile PLM installer is a Java program. The installation of all components follows the same initial
process up through the panel where you select the components to install.

Before running the installer, make sure

o You have read and completed the pre-installation checklist. You should also read and follow
the installation checklist for each Agile PLM component you plan to install. See “Installation
Checklists (on page 1).”

= You have enough available disk space.
Windows: at least 500MB of available disk space

UNIX: at least 1700MB of available disk space on the drive where your default Temp directory is
located.

o You have disabled virus protection.

If virus protection is enabled, components used in the installer can be falsely identified as being
infected and lock up the installation. You can enable virus protection after the installation is
complete.

To start the Agile PLM installer on Windows:
Log in to the computer using a login with local Administrator permissions.
1. Inthe Disk1\Windows directory, double-click the setup_win.exe file.

Note If there is insufficient TEMP disk space available to complete the installation,
you will be prompted for another location. Click Choose, select another drive,
Click OK, and the installer will start.
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After a few moments, the Welcome screen appears.

2. For information about any screen in the installer, click Help.

To start the Agile PLM installer on UNIX:

1. Log into the system.

Note If you are installing the Agile Application Server, make sure you log in as the
same user that installed BEA WebLogic Server.

2. Open a terminal window.

3. Go to the directory where you copied the Agile PLM files. Locate the setup_<OS>.bin file, and
run the program by typing the following:

AIX: /setup_aix.bin

Linux: ./setup_lin.bin

Solaris (SPARC): ./setup_sol.bin
Solaris (X86): ./setup_solx86.bin

After a few moments, the Welcome screen appears.

4. For information about any screen in the installer, click Help.

Installer Online Help

Each installation panel has online help. At any time during installation, you can click Help for more
information about the panel’s options.

Note If you leave the online help window open, it will be updated when you proceed
through the installer panels. Otherwise, click Close at the bottom of the help
window.

Installer Buttons

Agile PLM installation panels have the following buttons:
@ Cancel — Exits from the installation program.

o Help — Displays online help.

o Previous — Returns to the previous step.

o Next — Proceeds to the next step.

@ Install — Starts installing. The Install button appears only on the Pre-Installation Summary
panel, after you have specified installation options.

o Done — Exits from the installation program. On Windows, after installing certain components
you can choose whether to restart the computer when you click Done. The Done button appears
only on the Install Complete panel, after you have finished installing.

Agile PLM Components

During Agile PLM installation, you must select components to install. Choose from the following
components.
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Component Platform Installation/Configuration Documentation

Application Server Windows/Solaris/Linux/Al Configuring the Agile Application Server (on page 19)"and
X Configuring Application Server Clusters (on page 23)

File Manager Windows/Solaris/Linux/Al | Chapter 6, “Configuring the File Manager”
X

Web Proxies Windows/Solaris/Linux/Al | Chapter 7, “Configuring a Web Proxy Server for Agile PLM”
X

ChangeCAST Client Windows See online help for the Agile PLM installer.

(Upgrade only)

Portlet Services Windows/Solaris/Linux/Al | See the separate Agile Portlet Services Installation and Configuration
X Guide.

API Windows/Solaris/Linux/Al | See online help for the Agile PLM installer.
X

Agile PLM Installation Modes

When installing Agile PLM, you can install in Basic or Advanced mode. Basic mode should be
selected to install a standalone system on Oracle Application Server with the following system

defaults:

o Agile Application Server Virtual Path (default:Agile)

o File Manager User Authentication (default:ifsuser/agile)

o File Manager Virtual Path (default:Filemgr)

If you prefer to use values different from these defaults, then select Advanced mode. In Advanced
mode, you can install a standalone or cluster system on Oracle Application Server or BEA
WebLogic and change the defaults above, if desired.

Agile PLM Installation Folders

After you install Agile PLM, the following folders appear in the AGILE_HOME folder.

Note This list includes the folders for all Agile PLM components, although it is not
necessary that you install them all on one computer.

Folder Description
agileDomain Agile Application Server
AgileProxies Web proxy configuration files
changecast ChangeCAST client
install Installation and configuration scripts
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Folder Description
integration Agile Integration Framework (AIF) products such as Agile Integration Services (AIS) and Agile SDK
jdk Java Development Kit 1.5.0_06
Portlet 51 Agile Portlet Services for WebSphere Portal 5.1.0.2
Tomcat Tomcat 5.0.30
Uninstaller Agile PLM uninstaller

Agile PLM Windows Services

After you install Agile PLM on BEA WebLogic for Windows, the following Windows services are

added to your system:

Service

Description

Agile ChangeCAST

Agile ChangeCAST service

Apache Tomcat

Apache Tomcat service. Start this service to start Agile File Manager.
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Configuring the Agile Application Server

This chapter includes the following:
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= Application Server INStallation SEQUENCE ........ccvuieuriirrrieie et ses s 19
= Testing the Agile Application SErver CONNEBCHION. ........ccvvirririreierieessee e ese s 19
= Checking YOUr AGle PLIM SYSIEIM ...ttt ettt bbb 20

Overview of the Agile Application Server

The Agile Application Server is the center of the Agile system, the base for the PLM platform, where
all common services and business logic reside for the entire solution. The installation of the Agile
Application Server also includes Agile Content Service.

The Agile Application Server runs on either Oracle Application Server 10g or BEA WebLogic 8.1
SP6. All client servers including Portal Server, Viewer, and users connect to the Application Server
either directly or indirectly through a proxy web server.

Application Server Installation Sequence

Follow these steps to install the Agile Application Server:
1. Install BEA WebLogic 8.1 SP6.

See the BEA product documentation at http://e-docs.bea.com/wis/docs81/index.html (http://e-
docs.bea.com/wls/docs81/index.html) for installation instructions.

2. Install the Agile Application Server.
See “Installing Agile PLM (on page 11)."

3. Verify that the Agile Application Server is working properly.

See “Testing the Agile Application Server Connection”.

Testing the Agile Application Server Connection

You can now test the connection over the specified ports to the Agile Application Server.

Important It is important that you do not provide users with this URL. The port you specified during
the Application Server installation is not standard and should not be used by external or
remote Agile Web clients. This URL is a direct connection to the Application Server, and it
should be used only for testing and troubleshooting purposes.

To test the Agile Application Server connection:
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4. Start the Agile Server.

a. Windows: Choose Start > All Programs > Agile > Agile 9.2.2.4 > Start Agile Server to start the Agile
server, if it is not installed as a Windows service.

UNIX: Run the StartAgile.sh script located in the /opt/Agile/Agile9224/agileDomain/bin
directory

b. A Command Prompt window appears. This window must remain open, but can be
minimized, for users to access Agile Web client.

5. When starting the Agile Server for the first time, the following prompt appears:

1) Encrypt protected attributes in config.xml that are not
encrypted and then delete the config.xml.original with protected
attributes in clear-text.

2) Encrypt protected attributes in config.xml that are not
encrypted and overwrite config.xml.original with the new
config.xml

3) Encrypt protected attributes in config.xml that are not
encrypted but leave config.xml.original with protected attributes
still in clear-text.

Enter the value that meets your system requirement.

Wait until the following message appears in the command window: “Agile PLM Server Starting
Up”.

1. Open your browser and use the following URL to test the Agile Web client setup:

http://application _server:port/virtual path/PLMServlet

Note The URL is case-sensitive.
A login window appears.
2.  Enter the username and password.

The first time you log in to the Agile Web client, it may take a while to load the information.

Checking Your Agile PLM System

Before using Agile Integration Framework (AlF) products such as Agile Integration Services (AIS) or
the Agile SDK, you must ensure that the system is properly configured.

For more information about using AlS and the Agile SDK to develop custom solutions for Agile
PLM, see the separate Agile Integration Services Developer Guide and the Agile SDK Developer
Guide, respectively.

Checking Whether Agile Web Services Work

Before trying to compile and run the sample AIS web service clients, or developing custom web
service extensions to the Agile PLM system, make sure your server is working properly. First, try
accessing the following URLSs to see if they correctly return WSDL from the server.

1. http://aqgileserver/virtualPath/integration/ws/Importer?wsdl

2. http://agileserver/virtualPath/integration/ws/Export?wsdl

3. http://agileserver/virtualPath/integration/ws/ResponseService?wsdl
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All three URLs should return WSDL. If any do not, contact Customer Support.

Checking Whether the Agile SDK Works

If you purchased a license to the Agile SDK, Agile PLM provides both server-side and client-side
components that allow you to develop Java programs and web services that extend the functionality
of Agile PLM and help you integrate it with other applications. Before beginning to develop Agile
SDK programs, make sure your system is working properly. You should be able to establish a
connection with the Agile Application Server or the proxy web server used for the Agile PLM
system. You should also be able to create an Agile PLM session and download classes from the
server.

Checking Your Connection

To check your connection, access the following servlet URL that is installed with Agile PLM:
http://<servername>.<domain>:<port>/<virtualPath>/ServerAPIProperties
For example, the URL might look something like this:

http://plm.yourcompany.com/Aqile/ServerAPIProperties

The servlet should return the following information:

= Minimum Agile API version needed to connect to the server
o Current Agile PLM server version

o Current Agile PLM release

= Agile PLM session class

= Agile PLM authenticator class

o Agile PLM application server type

o name/value pairs for environment variables

If the page cannot be found, you are unable to connect to the server. There are several possible
causes for the problem:

o You typed the URL incorrectly.
o The server may be down temporarily.

= You may be experiencing problems with your network.

Whatever the cause, you must fix the problem before you can run an Agile SDK client. If you need
help, contact your company’s Help Desk or your Agile PLM administrator.

Granting Write Permission to the AgileSDK.cache and sdk.extensions.lib Folders

When you run an Agile SDK client program, it connects to the Agile Application Server and
automatically downloads the classes it needs into a local cache folder named AgileSDK.cache.
Similarly, when you run a process extension from one of the Agile PLM clients or invoke a web
service extension, the server automatically copies any updated libraries into a folder named
sdk.extensions.lib before loading them. On Windows, these folders are created automatically in the
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c:\Documents and Settings\<username> folder and there is never any need to modify them.
However, on Unix-based operating systems such as Solaris and Linux, the system administrator
must create the /tmp/AgileSDK.cache and /tmp/sdk.extensions.lib folders and grant users write
access to them.

Important If you don’t have write access to the /tmp/AgileSDK.cache and /tmp/sdk.extensions.lib
folders, you won't be able to run Agile SDK client programs, use process extensions from
Agile PLM clients, or use Agile PLM web service extensions. Please see your system
administrator and make sure you have proper access to those folders.

Setting the sdk.extensions Property

If your company uses the Agile SDK to develop process extensions or web service extensions, the
finished programs are copied to the AGILE_HOME\integration\sdk\extensions folder located on the
Agile Application Server. From there, the server uses special-purpose class loaders to load the
programs when they are invoked.

The agile.properties file located in AGILE_HOME\agileDomain\config contains an sdk.extensions
property that specifies the location of the extensions folder. If process extensions, web service
extensions, or the Agile File Management Server (which is actually a web service extension) don’t
run successfully, it could be because the sdk.extensions property is set incorrectly and does not
match the location where the programs have been placed.

Note Ordinarily, you should never need to edit the agile.properties file. The sdk.extensions
property should be set correctly when you install Agile PLM. If you modify the
sdk.extensions property, you must restart the server.
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Configuring Application Server Clusters
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About Agile Application Server Clusters

Agile takes advantage of clustering capability provided by the supported application servers. A
cluster is a group of servers that work together to provide a more scalable, more reliable application
platform than a single server. A cluster appears to its clients as a single server, but is actually a
group of servers acting as one. A cluster provides two key advantages over a single server:

o Scalability: The capacity of a cluster is not limited to a single server or a single machine. New
servers can be added to the cluster dynamically to increase capacity. If more hardware is
needed, a new server on a new machine can be added. If a single server cannot fully utilize an
existing machine, additional servers can be added to that machine. But this is not a supported
configuration unless you are using a product like VMWare or partitions or containers.

o High-Availability: A cluster uses the redundancy of multiple servers to insulate clients from
failures. The same service can be provided on multiple servers in the cluster. If one server fails,
the surviving members can continue to serve the application. The ability to fail over from a
failed server to a functioning server increases the availability of the application to clients.

Traffic to multiple application servers needs to be managed or balanced by some device in-between
the server cluster and the clients. There are two main components that provide this capability;
reverse-proxy web servers or load balancing hardware.

Firewall Considerations for Clusters

In any cluster architecture that uses one or more firewalls, it is critical to identify all Application
Server instances using publicly available DNS names, rather than IP addresses. Using DNS names
avoids problems associated with address translation policies used to mask internal IP addresses
from untrusted clients. However, most security policies involve hiding (and denying access to)
internal IP addresses.

To avoid problems in all cases, bind Application Server instances to DNS names and use the same
DNS names both inside and outside the firewall. An alternative to using DNS names is to use
identical IP addresses inside and outside of the firewall. However, publicizing IP addresses is not
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recommended as it may compromise the security of the Web application.

Installing Agile PLM on the Administration and Managed
Servers

Install the Agile Application Server by starting the Agile PLM installer and following the instructions
in online help. See “Installing Agile PLM (on page 11).” Make sure you select Advanced Mode as the
Installation Mode and Cluster Installation as the Installation Type. The directory structure should be
the same on all of the servers in the cluster.

Setting Up a WebLogic Cluster

A WebLogic Server cluster is a group of WebLogic servers that work together to provide a scalable,
more reliable application platform than a single server. A typical cluster configuration contains one
WebLogic domain administration server and one or more WebLogic Managed servers. BEA
recommends that all the WebLogic servers should be located in the same subnet to ensure the
multicast messages are reliably transmitted.

The following are assumptions that the Agile PLM 9.2.2.4 installer has performed successfully:

= The necessary files are installed (the cluster version of config.xml and the application.ear files)
on the WebLogic Domain Administration server only

o The config.xml file is populated with the cluster name and cluster IP multicast address.

o Agile PLM 9.2.2.4 is installed on each WebLogic Managed server, and each instance includes
the WebLogic Managed server startup script, which contains the administration server name.

The cluster setup includes configuring the number of WebLogic Managed servers in a cluster,
adding them to the cluster, and targeting a JMS server to one of the newly created WebLogic
Managed Servers.

Starting the WebLogic Administration Server

To start WebLogic Administration Server, go to the <Agile_dir>\agileDomain\bin folder on the
computer where Administration Server is installed and run the startAgile script.

When starting the server for the first time, the following prompt appears:

1) Encrypt protected attributes in config.xml that are not
encrypted and then delete the config.xml.original with protected
attributes in clear-text.

2) Encrypt protected attributes in config.xml that are not
encrypted and overwrite config.xml.original with the new
config.xml

3) Encrypt protected attributes in config.xml that are not
encrypted but leave config.xml.original with protected attributes
still in clear-text.

Enter the value that meets your system requirements.
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Configuring the WebLogic Managed Servers

The following steps are used to configure each WebLogic Managed server on the Administration server:
1. Start WebLogic Administration server by running the startAgile script.
2. Open the Administration console by typing the following:

http://localhost:<port_number>/console

Important This URL should be protected to prevent access from other users.

3. The default user login is superadmin, and the password is agile.

4. On the left pane, click Console > AgileDomain > Servers.

5. right-click on the list of servers, then choose Configure a new Server.

6. Type the values for the following attribute fields:
®* Name - The name of the managed server. This name is case-sensitive.
* Listen Port - This should be same for all WebLogic Managed servers.
* Listen Address - Enter the IP address of the WebLogic Managed Server.
®  Cluster - Select AgileCluster from the drop-down list.

7. Click Create to create the new WebLogic Managed server.

8. Repeat steps 4 through 7 for each WebLogic Managed server.

9. Restart the Administration Server.

Adding Managed Servers to the Cluster

The following steps are used to add WebLogic Managed servers to the cluster.
1. Open the Administration console if it is not already opened.

2. Click the Clusters node.

3.  Click the AgileCluster link in the right pane.

4. Enter a value for the Cluster Address attribute:

This address can be either a DNS host name that maps to multiple IP addresses or a comma
separated list of single address host names or IP addresses of the managed servers. Make
sure there are no spaces between the comma and the IP address or host name. For example,
if the IP address of the managed server 1 is 10.10.5.84 and the IP address of managed server
2is 10.10.5.91, the cluster address value should be 10.10.5.84,10.10.5.91.

Click Apply.
Restart the Administration server.

Note Whenever modifying an attribute with an exclamation point next to it, it is
required to restart the Administration server.

7. After the Administration server is started, open the Administration console.
Click the Cluster node.
Click AgileCluster.
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10. Click the Servers tab.

11. Verify the WebLogic Managed server is listed in the Chosen list. If not, select the WebLogic
Managed server under the Available list and click the arrow button.

12. Click Apply.

Configuring a Distributed JMS Cluster on BEA WebLogic

In Agile PLM, a WebLogic cluster has one JMS server on each managed server in the cluster. The
JMS queues and topics are configured as distributed destinations with each JMS server hosting a
member of the destination. This configuration facilitates JMS load balancing and failover support for
the cluster.

To configure a JMS cluster:

1. Start the WebLogic Administration Server for the cluster and log in to the Admin console:
http://<adminservername>:<adminserverport>/console

On the left pane, click Services > JMS > Servers.

right-click the Server tab in the right pane, then select Configure New JMS Server.

Type a unique name for the new JMS Server in the Name field, then click Create.

o b 0w

Click the Targets tab and select a managed server that has not been associated with a IMS
server from the drop-down list.

6. Click Apply.

7. Repeat steps 2 through 6 to create JMS servers for all other managed servers in the cluster.
8. On the left pane, click Services > JMS > Distributed Destinations.

9. double-click one of the distributed destination components, then click the Auto Deploy tab.
10. Click the Create members on the selected Servers (and JMS Servers) link.

11. Select the cluster from the drop-down list as the target for the distributed destination
component, then click Next.

12. Select all of the managed servers to create the members for the component., then click Next.
13. Select all of the JMS Servers to create the previously selected members, then click Next.

14. Click Apply.

15. Repeat steps 9 through 14 for the remaining distributed destination components.

16. Restart the WebLogic Administration Server.

Starting the WebLogic Managed Servers

To start the WebLogic Managed Servers, go to the <Agile_dir>\agileDomain\bin folder on each
computer where a Managed Server is installed and run the startAgileCluster script.
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Deploying the Application

The following steps ensure that the necessary applications are deployed correctly.
1. Open the Administration console.
2. Click the Deployments > Applications > Agile nodes.

3. Foreach file listed,
a. Select the file name, then click the Targets tab on the right pane.

b.  Click the checkbox, if not already checked, for all of the servers where you are deploying
the application.

c. Click Apply.

4. Restart the WebLogic Administration Server.

Configuring the Load Balancer

A load balancer is deployed to balance user load across a cluster. When external users need
access to Agile, this device is deployed in the DMZ. Load balancers can be used with the Java
client and the Web client.

To configure a load balancer:

o Configure three virtual IP addresses, one for the application server web client (port 7001), one
for the application server Java client (port 23791, internal users only), and one for the File
Manager (port 8080 by default).

o Set the load balancer policy to Round-robin.

To access the system after you have configured the load balancer, use an alias for the virtual IP
address of the load balancer in the Agile web and Java client URLs. The following URL is an
example:

http://loadbalancer.mydomain.com/Agile/PLMServiet

or

t3://loadbalancer.mydomain.com/Agile
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Configuring the File Manager

This chapter includes the following:
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About File Management

The File Manager manages files in a repository or vault in the file system. A File Manager provides
a place to store and retrieve files locally or remotely. The File Manager can be installed on the same
machine as the Agile Application Server or on a separate machine. The server can also be installed
in a cluster or distributed across geographic regions.

The Agile Viewer communicates with the File Manager which in turn makes calls to the Agile
Application server using the HTTP protocol. Because of this, if Agile View Server is licensed, it is
recommended that the Agile View Server be installed on the same machine as the Agile File
Manager, if sufficent resources are available.

In the preferred clustered environment, File Managers run on each application server node
managing a shared drive. In a distributed environment, files are stored locally for efficient
downloads and uploads. If a file is not found on a local file manager, the file is replicated from the
primary file manager. The primary file manager is the file manager that is local to the application
server.

Distributed File Managers

Multiple Agile File Managers can be deployed in a distributed configuration with or without a
reverse-proxy web server (Microsoft IIS or Apache HTTP Server) in the DMZ. A Distributed File
Manager configuration allows you to install additional file managers at remote locations so that
remote sites can store and retrieve files locally, while still making the files available to the Agile PLM
system. This can reduce the download time by placing file managers close to remote clients.

The determination for using distributed file management is based on your Agile end-user locations
and network configuration. In general, the following criteria can help you to determine if you need
additional file managers:

o Multiple remote locations

If you have multiple remote sites connected over a WAN, clients at remote locations who need
to store and retrieve files from the main file manager can experience large time delays.

o Reducing inter-network traffic

If your network is divided into subnets to reduce network traffic, then you should consider
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putting a file manager in each subnet that contains Agile users to reduce your intersubnet
network traffic.

The usage model for a distributed file manager configuration is as follows:

u]

The File Manager located nearest to the application server should be designated the primary
File Manager.

Users upload and download files from their preferred File Manager.

File replication between File Managers is on-demand. When a remote user requests a file that
does not exist on their preferred File Manager, the system copies the file to the remote user's
preferred File Manager.

Checking out and checking in files is the same as adding and getting files.
Viewing a file or viewing a redline file is similar to getting a file.
Redlining a file is the same as adding a file.

Deleting a file only removes references to the file. Use the vault utility to clean up additional
files on non-primary file managers.

Deployment Configurations

You can deploy the File Manager in either a standalone or cluster configuration.
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Standalone

The following figure shows a single server standalone deployment configuration. The web server in
the DMZ forwards calls to the Application Server as well as the File Manager.

Javafweb Client

Firewall

DMZ
Web Server
A
—
Internal — —
MNetwork [—=| =
=] (=]
== =
] |-
Il AR
i — I][I[II]I][I[I-.__ﬂ
File Manager Application Server
{Tomcat)

If you plan to install the Application Server and File Manager on the same box (co-deploy), choose
both components during Agile PLM installation.

Cluster

The preferred cluster deployment configuration is shown in the following figure. Each node in the
cluster has the Application Server and File Manager deployed. File Managers have a shared disk
for file vaults. Each File Manager communicates with the local application server for optimized
performance. The File Managers join in a Tomcat cluster to support failovers. The Load Balancer
exposes two virtual IP addresses, one for the application server and one for the File Manager.
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When installing this type of cluster, choose both the Application Server and File Manager
components during Agile PLM installation before selecting the Cluster configuration.
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You can also choose to deploy the File Manager cluster and Application Server cluster on separate
machines, but that configuration requires more hardware. If you choose to install this type of setup,
the Application Servers and File Managers should be installed separately before configuring and
validating.

application Serwver Cluster

Firewall

Load Balancer

File Manager Cluster

File Manager C

File Manager B

Configuring the File Manager

After installing the File Manager and setting up a load balancer or reverse-proxy server for it, you
must configure the File Manager settings in the Java Client.

Note Before configuring the File Manager, make sure you set up a load balancer or
reverse-proxy server.

To configure File Manager settings:

1. Start the Agile Application Server.
a. Windows: Choose Start > All Programs > Agile > Agile 9.2.2.4 > Start Agile Server.

UNIX: Run the StartAgile.sh script located in the /opt/Agile/Agile9224/agileDomain/bin
directory

b. A Command Prompt window appears. This window must remain open, but can be
minimized. Wait until the message, “Agile PLM Server Starting Up”, appears in the
window.

2. Start the Agile Java Client, as described in “Installing and Configuring Agile Java Client (on
page 75)".

Log in as an Agile Administrator user.
Click the Admin tab.
Choose Server Settings > Locations. The Server Location window appears.
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6. Click the File Manager tab to bring it forward.
double-click the entry to display the File Manager dialog box.
8. Click the Advanced button and check the Viewer Content URL.

File Manager EI

Marme IiFS —

File Manager URL |h1:tp:,-‘,-’plmserver.agile.agileauﬁ.cum:BEI,-‘FiIemgrmttachmentS

Enabled I‘r‘es

Prirary file server I‘r‘es

File Manager Internal Locator |h1:tp:,","plmserver.agile.agilesuﬁ.cum:BD;‘FiIemgr;’services;’Filef

Viewer Server URL |h1:tp:,-‘,-’plmserver.agile.aqilesuf’t.cum:BEIfFiIemngueServlet

Wiewwer Proxy URL |http:,","plmserver.agile.agilesn:uﬁ.n:n:nm:BDfFiIemngueLink

Viewer Content URL |h1:tp :/fplmserver agile. agilesoft.com:80/agile/jvue

rhet=file Caching

[~ Enable/Disable MetaFile Utility

YLe Server Host |

“YLe Server Part |

Yault Configuration

+ | x | -
o | of

Ok, Cancel |

9. Enter the value of the File Manager URL.
The File Manager URL is the URL the Agile Web Client connects to. The format is:
http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/AttachmentServlet

10. Click the Standard Vault Type to display the drop-down list.
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You can choose to have Standard or Custom vault. A standard vault is the default vault type that
contains the new files and redlines, while a custom vault allows you to attach a disk of data to
Agile PLM as-is without reorganizing the files. A custom vault is always set up as read-only.

You can attach an arbitrary file structure to the File Manager without the files being uploaded.
Refer to the Agile PLM Import and Export Guide for more information on how to configure
FileLoad for custom vaults.

11. Enter a description of the vault in the Description field.

12. Verify that the primary location where the files are stored in the Base Storage Directory field is the
same location you entered during installation. The default location is \files. The location can be
a shared network storage directory, such as a Storage Area Network (SAN).

Important Do not specify a mapped drive which may not be mapped automatically after a reboot.
Instead, specify a local drive or UNC name include directory path, like this:

\\fileserver\filevault

13. Enter a location where the purged (deleted) files are automatically moved in the Purge Directory
field. The default location is AGILE_HOMEfiles\purge. The location can be a shared network
storage directory, such as a Storage Area Network (SAN).

Important Do not specify a mapped location. Instead, specify a local drive or UNC name including
directory path, like this:

\\fileserver\filevault\purge

14. Set the vault as Read-Write or Read-Only from the Category drop-down list. Each File Manager
can have only one Read-Write vault.

If you have multiple vaults, then the additional vaults should be defined as Read-Only.

=+
15. Click the plus-sign

16. Click OK when done.

to add additional vaults.

17. Start the File Manager (Tomcat). For instructions, see the next section, “Starting the File
Manager.”

There are additional configuration settings used to fully configure File Manager through the Java
Client. These settings are:

o Filename Prefix (Preferences)
o Checksum computation (Preferences)

= DFM Optimized Replications (Preferences)

For more information on these additional settings, see the Agile PLM Administrator Guide.

Reconfiguring File Manager After Setting Up a Web Proxy Server

If you set up a Web proxy server for Agile File Manager that is different from the server or port you
specified when you installed Agile PLM, you must make sure that File Manager points to the proxy
server on the correct port. Otherwise, File Manager may not start successfully and Agile PLM
clients won't be able to access file attachments.

Page - 35



Installing Agile PLM for WebLogic

For instructions on setting up a Web proxy server for File Manager, see “Configuring a Web Proxy
Server for Agile PLM (on page 39).”

To configure File Manager after setting up a Web proxy server:

1. Configure File Manager locations in Java Client. See “Configuring the File Manager (On page
29)".

2. Stop the File Manager.

3. Backup the existing File Manager configuration:
a. Change to the AGILE_HOME\Tomcat\webapps directory.
b. Verify there is a directory named Filemgr under the webapps directory.
c. If the Filemgr directory exists, then perform the following:

cd ..
mkdir webapps.old

Windows: move webapps\Filemgr webapps.old
UNIX: mv webapps/Filemgr webapps.old

Create a backup of the AGILE_HOME\agileDomain\applications\webfs.war file.

Create an empty temporary directory. Make sure there are no spaces in the path to the
temporary directory.

6. Copy the webfs.war file to the temporary directory.
From a command line, change to the temporary directory and run the following commands:
set PATH=\AGILE_HOME\jdk\bin; $PATH%
jar -xvf webfs.jar

8. After the files are extracted, change to the WEB-INF\classes\com\agile\webfs\configuration
directory.

9. Using a text editor, open the server.conf file for File Manager.

10. Find the file.server.url entry, and update it to reflect the proxy server hostname or alias and
port number. After you modify the file.server.url entry, it should look something like this:

file.server.url =http://webserver.company.com:80/Filemgr/services/FileServer

Note The file.server.url entry must match the File Manager Internale Locator entry
(definied in Java client: Server Settings > Locations) or the File Manager will
not initialize successfully.

11. Save the server.conf file.
12. Delete the webfs.war file from the temporary directory.

13. From a command line, run the following command to recreate the webfs.war file:

jar -cvf webfs.war *

14. Copy the newly created webfs.war file to the \AGILE_HOME\agileDomain\applications
directory.

15. Perform steps 4-14 on the \AGILE_ HOME\Tomcat\server\lib\agile-sso.jar file. Make sure you
create a backup of the agile-sso.jar file.
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16. Copy the newly created agle-sso.jar file to the \AGILE_HOME\tomcat\server\lib directory.
17. Restart the File Manager (Tomcat).

Starting the File Manager

After you have configured the File Manager, you can start the server.

To start the File Manager on Windows:
1. Choose Start> Administrative Tools > Services.
2.  Start the Apache Tomcat service.

You can check for errors in the stdout and stderr logs in the AGILE_HOME\Tomcat\logs
directory.

To start the File Manager on UNIX:

1. Open aterminal window.

2. Change to the /opt/AGILE_HOME/Tomcat/bin directory.

3. Set and export the JAVA_HOME variable on the command line:
> JAVA_HOME=/opt/AGILE_HOME/jdk
> export JAVA_HOME

4. Start the File Manager:

> [startup.sh

Validating the File Manager Installation

To verify that the File Manager installed successfully, check the following URL:
http://<fileserver _host>:<port>/<fileserver_virtual_path>/Configuration

For example, you might type the following URL:
http://filevault. mycompany.com:8080/Filemgr/Configuration

If you are using a Web proxy server for File Manager, the URL might look like this:
http://webproxy.mycompany.com:80/Filemgr/Configuration

After a moment, the File Manager Configuration page should display. This page tests the File
Manager and Application Server connections. If Success is listed in the Status column for all
connections, your installation was successful.
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Chapter 7
Configuring a Web Proxy Server for Agile PLM

This chapter includes the following:

B OVBIVIBW ..ottt bbb s8££ 888 R R bbb 39
= Testing the Agile Application SErver CONNECHON. .........cccvvirrieireieri e ese s 42
= Configuring IS @s a Proxy Server for AGIle PLIM ..ot esssesssens 42
= Configuring IIS as a Proxy Server for Agile File MANAGEY ... e 44
= Configuring the Apache Web Server as a Proxy Server for Agile PLM and Agile File Manager............cccoevuen. 47
= Logging In to the Agile WED CHENE ........cvvieieer s
= Troubleshooting the Agile Web Client
Note It is recommended that you install the Agile Web proxy files on the Web server
in the DMZ. Agile Viewer should be installed on its own computer within the
corporate firewall. For information about configuring Agile Viewer, see
“Configuring Agile Viewer.”
Overview

The Agile Web client is a fully functional Web interface that allows Agile-enabled manufacturers to
securely provide internal users and trusted supply chain partners access to Agile PLM.

To connect to the Agile Web Client on a Web proxy server, Agile Web proxy files must be installed
on the Web server. Agile Web Client uses Microsoft Internet Information Services (IIS) or Apache
Web Server. The Agile Web client connects to an Agile Application Server in the same manner as
all other Agile Application Server clients. Secure access is maintained using SSL encryption with
HTTPS and is recommended for the Internet. Standard firewall configurations are supported by the
Web server.

Agile Internet Security

A Web browser uses the Agile Web client to communicate with the Agile Application Server over the
Internet using the HTTPS protocol, which uses the Secure Sockets Layer (SSL) protocol. SSL is a
standard Internet connection-based protocol for secure communications.

Recommended Security Practices

It is important that you change all default passwords for both Agile PLM and the database. In
addition, users should change their passwords at least every 30 days.
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Configuring Internet Information Server

Before you install Agile Web proxy files on Windows, a Microsoft Internet Information Server (l1S)
must be installed on the same computer. In addition, IIS must be configured as follows:

1. Choose Start > Administrative Tools > Internet Information Services (IIS) Manager, and create a new
web site called Agile PLM Web Site. For more information on how to create a web site, see the
Internet Information Server documentation online at the Microsoft TechNet:
http://technet.microsoft.com/

Note Due to security vulnerabilities, we recommend that you don’t use the Default
Web Site installed with Internet Information Server. You can either delete or
disable the Default Web Site.

right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.

3. Select the Directory Security tab and click Edit for Anonymous Access and Authentication
Control.

4. Make sure Enable Anonymous Access is checked.
5. Uncheck Integrated Windows authentication.

6. Click OK.
Also, search the \\winnt\system32 folder for the wininet.dll file. The file must be at least version

5.00.2919.6305 or later. Install at least Internet Explorer version 5.00.2919.6305 to update the DLL
file.

For security reasons, Agile recommends installing Agile Web proxy files on a server separate from
other Agile PLM servers.

Firewall Configuration

An external user typically runs the Agile Web client in a browser from outside the corporate network.
The client typically communicates over the Internet to the Agile servers behind a corporate firewall.

If you want to use HTTPS, firewalls must be configured to allow for connectivity from the Agile Web
clients to the DMZ reverse-proxy web server or load balancer and from the DMZ reverse-proxy web
server or load balancer to the Agile PLM Application Servers and File Managers.

The corporate firewall on the Agile application side must be configured to allow:
= Incoming HTTPS connections from the Internet to the Web server

@ Qutgoing TCP/IP connections from the Web server to the Application Server

Important On Windows, encryption is supported only between IS and the client’s browser, not
between IS and the Application Server. Do not put a certificate on the Application Server.

Deployment Scenarios in the DMZ

This section contains deployment scenarios. For deployment diagrams, see the Capacity Planning
and Deployment Guide.
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Single Firewall

In the first scenario, there is only one firewall between the DMZ and internet.

In this setup, the computers in the intranet are referenced by a single IP address. There is no
network address translation (NAT) between the DMZ and intranet. Only the Web server in the DMZ
is referenced by two IPs or hostnames. Agile Web clients are deployed in this environment as
follows:

o The Web server resides on one computer in the DMZ with the Agile Application Server, Agile
Viewer, and the database residing in the Safe Zone.

When the Application Server and Agile Web proxy files are installed, you must open application
server-specific HTTP/HTTPS ports from the DMZ to the intranet. This enables communication
between the 1IS Web server proxies and the Agile Application Server. The application server-
specific ports must be dedicated and bidirectional between the Web server in DMZ and
application server in the intranet.

You are not required to open any other ports from the DMZ to the intranet.
Advantages:
* Firewall friendly and secure without exposing Agile in the DMZ.

* Modest performance boost because Agile Web proxies reside with other Agile Application
Server components

Disadvantages:
* An additional computer is needed.
* Additional configuration requirements.
1. Install the Agile Web proxy files on the IS computer in the DMZ.
Set up the IIS folder as specified in this chapter.

3. Copy the Agile Viewer jVue applet folder (located in the \\inetpub\wwwroot folder) from the
computer where IIS is installed (either the Agile Web client computer or the Viewer computer)
to the same folder location on the IS computer in the DMZ.

Two Firewalls

In the second scenario, there are two firewalls—one between the DMZ and the internet, and one
between the DMZ and the intranet. In this setup, the computers in the intranet are referenced by
two IP addresses. There is IP address translation or network address translation between the DMZ
and intranet to enable mapping external IP addresses to internal IPs of the computers. However, in
such environments, third-party vendor applications typically encounter problems with firewall
configuration.

= The IS Web server resides on one computer in the DMZ, and the Agile Application Server
resides on another computer in the intranet with Agile Viewer and the database.

Advantages:
* Firewall friendly and secure without exposing Agile in the DMZ.

* Modest performance boost because Agile Web proxies reside with other Agile Application
Server components

Disadvantages:
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* An additional computer is needed.
* Additional configuration requirements.

Testing the Agile Application Server Connection

You can now test the connection over the specified ports to the Agile Application Server.

Important It is important that you do not provide users with this URL. The port you specified
during the Application Server installation is not standard and should not be used
by external or remote Agile Web clients. This URL is a direct connection to the
Application Server, and it should be used only for testing and troubleshooting
purposes.

To test the Agile Application Server connection:

1. Start the Agile Server.
a. Windows: Choose Start > All Programs > Agile > Agile 9.2.2.4 > Start Agile Server to start the Agile
server, if it is not installed as a Windows service.
UNIX: Run the StartAgile.sh script located in the /opt/Agile/Agile9224/agileDomain/bin
directory
b. A Command Prompt window appears. This window must remain open, but can be
minimized, for users to access Agile Web client.

Wait until the following message appears in the command window: “Agile PLM Server
Starting”.

2. Open your browser and use the following URL to test the Agile Web client setup:

http://webserver host:port/virtual path/PLMServlet

Note The URL is case-sensitive.

A login window appears.
3. If you have not added Agile users, type admin for the user and agile for the password.

The first time a user logs in to the Agile Web client, it may take a moment to load the
information.

Configuring IIS as a Proxy Server for Agile PLM

When you install Agile Web proxies, the setup program creates the AGILE_ HOME\AgileProxies
folder. For example, if you accepted the default installation location at D:\Agile\Agile9224, the
AgileProxies folder appears in that folder.

The AGILE_HOME\AgileProxies folder contains the following proxy files that enable communication
between the IIS Web server and the WebLogic server:

o lisproxy.dll
o jisforward.dll

= iisproxy.ini or iisproxy_cluster.ini (initialization file to direct the proxy filters where to route the
HTTP/HTTPS traffic specific to Agile from IIS)
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To set up an Agile Web proxy on IIS for BEA WebLogic:

1.

10.

11.

12.
13.

14.
15.

16.

17.
18.

19.

On the Web server computer, Choose Start > Administrative Tools > Internet Information Services
(11S) Manager.

The Internet Information Services Manager window appears.
Expand the folder for Internet Information Services > servername.
right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.

The Agile PLM Web Site Properties dialog box appears.

Note Due to security vulnerabilities, we recommend that you don't use the Default
Web Site installed with Internet Information Server and instead create a new
Web site named Agile PLM Web Site. For more information, see “Configuring
Internet Information Server (on page 40)".

Click the Home Directory tab.

Set the permissions to Scripts and Executables.

Click Configuration.

The Application Configuration dialog box appears.

Click Add.

The Add/Edit Application Extension Mapping dialog box appears.

Click Browse and locate the iisproxy.dll file from the AGILE_HOME\AgileProxies folder. After
you select the iisproxy.dll file, click Open to close the dialog box.

Type .wiforward in the Extension field.

Uncheck the Script engine and Verify that file exists boxes, and then Click OK.
The Application Configuration dialog box appears.

Notice the .wiforward extension appears in the Application Extensions list.
Click OK.

The Agile PLM Web Site Properties dialog box appears.

Select the ISAPI Filters tab.

Click Add.

The Add/Edit Filter Properties dialog box appears.

Type iisforward in the Filter Name field.

Click Browse and locate the iisforward.dll file from the AGILE_HOME\AgileProxies folder. After
you select the iisforward.dll file, click Open to close the dialog box.

In the Add/Edit Filter Properties dialog box, Click OK.
The Agile PLM Web Site Properties dialog box appears.
Click Apply.

If the Inheritance Overrides dialog box appears, select ISADMIN and Scripts (you can select
non-contiguous options by pressing Ctrl when you click the option). You can select all nodes in
the event of problems. Click OK.

Click OK to close the Agile PLM Web Site Properties dialog box.
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20. Select the Web Service Extensions folder.
21. Select All Unknown ISAPI Extensions.

22. Click Allow.

23. Close IIS Manager.

24. Restart lIS.

Note To restart 1S, stop all of the IS services through the control panel and then
restart them, or restart the computer. This ensures that the .dll is reloaded. Do
not use IS Manager to restart IIS.

Testing the Configuration

After you set up the iisforward ISAPI filter, you should test whether the filter loads successfully.

To make sure the iisforward filter added to ISAPI Filters tab is loaded properly on the Web server:

1. Type the Application Server PLMServlet URL into a browser (using the reverse-proxy web
server alias or hostnme and listen port) and make sure the Agile PLM login page loads
successfully.

2. Inthe IIS Manager, right-click the Agile PLM Web Site, and choose Properties from the shortcut
menu.

The Agile PLM Web Site Properties dialog box appears.
3.  Select the ISAPI Filters tab.

The status for the iisforward filter shows an arrow pointing up, indicating that it is loaded on the
IIS Web server and ready to proxy all external HTTP/HTTPS requests to the Agile Web client
server.

The IIS Web server is now ready to accept all external Agile Web clients using HTTP/HTTPS
requests on standard ports 80 and 443. The IIS Web server provides a proxy to the application
server running Agile Web clients on the port you specified during the Agile Application Server
installation.

If the arrow is not pointing up, the filter is not loaded properly.

To correct a filter that is not loading properly:

1. Open the Control Panel and double-click the Services icon.

2. Stop the IIS Admin Service (this also stops the World Wide Web Publishing service) and then restart
it.

Start the World Wide Web Publishing service.

4. Go back to the ISAPI Filters tab in the Agile PLM Web Site Properties dialog box.

The iisforward filter arrow should now point up.

w

Configuring IIS as a Proxy Server for Agile File Manager

When you install Agile Web proxies, the setup program creates the AGILE_HOME\AgileProxies
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folder. For example, if you accepted the default installation location at D:\Agile\Agile9224, the
AgileProxies folder appears in that folder.

The AGILE_HOME\AgileProxies folder contains the following files that enable communication
between the 1IS Web server and the File Manager (Tomcat):

o jsapi_redirect.dll - The IIS server plugin.
= workers.properties - A file that describes the hosts and ports used by Tomcat processes.
= uriworkermap.properties - A file that maps URL-Path patterns to Tomcat processes.

Note If you set up a Web proxy server for Agile File Manager that is different from
the server or port you specified when you installed Agile PLM, you must make
sure that File Manager points to the proxy server on the correct port. For more
information, see “Reconfiguring File Manager After Setting Up a Web Proxy
Server (on page 35)".

To configure IIS as a proxy server for File Manager:
1. On the File Manager computer, open the AGILE_HOME\Tomcat\conf/jk2.properties file.

2. Add the following entry, replacing @AJP-PORT@ with the actual AJP port number:
channelSocket .port=EeAJP-PORT@E

Note To see which AJP port number to enter, open the
AGILE_HOME\Tomcat\confiserver.xml file and look for the following section:
<!-- Define a Coyote/JK2 AJP 1.3 Connector on port 8009 -->

Note <Connector port="8009" enableLookups="false" redirectPort="8443" debug="0"
Note protocol="AJP/1.3" />

3. Onthe Web server computer, Choose Start > Administrative Tools > Internet Information Services (1IS)
Manager.

The Internet Information Services Manager window appears.
Expand the folder for Internet Information Services > servername.
right-click the Agile PLM Web Site, and choose Properties from the shortcut menu.

The Agile PLM Web Site Properties dialog box appears.

Note Due to security vulnerabilities, we recommend that you don’t use the Default
Web Site installed with Internet Information Server and instead create a new
Web site named Agile PLM Web Site. For more information, see “Configuring
Internet Information Server (on page 40)”.

6. Select the ISAPI Filters tab.
Click Add.
The Add/Edit Filter Properties dialog box appears.
Type Jakarta IIS Connector in the Filter Name field.

Click Browse and locate the isapi_redirect.dll file from the AGILE_HOME\AgileProxies folder.
After you select the file, click Open to close the dialog box.

10. Inthe Add/Edit Filter Properties dialog box, Click OK.
The Agile PLM Web Site Properties dialog box appears.
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11. Click OK to close the Agile PLM Web Site Properties dialog box.

12. right-click the Agile PLM Web Site, and choose New > Virtual Directory from the shortcut menu.
The Virtual Directory Creation Wizard appears.

13. Click Next.

14. On the Virtual Directory Alias page, type Jakarta as the alias name. Click Next.

15. On the Web Site Content Directory page, type the path where the isapi_redirect.dll file is
located. Click Next.

16. On the Access Permissions page, make sure the Execute checkbox is checked. Click Next.
17. Click Finish.

18. Close IIS Manager.

19. Open the workers.properties file in the AGILE_ HOME\AgileProxies folder.

20. Make sure the File Manager host name is correct in the following entry:

worker.ajp13w.host=<File Manager fully-qualified host name>

Note Make sure you can successfully ping the File Manager using the fully-qualified
host name and that the AJP port is not blocked by a firewall.

21. Save and close the file.
22. Restart IIS.

Note To restart IS, stop all of the IS services through the control panel and then
restart them, or restart the computer. This ensures that the .dll is reloaded. Do
not use IIS Manager to restart IIS.

Testing the Configuration

After you set up the Jakarta IIS Connector ISAPI filter, you should test whether the filter loads
successfully.

To make sure the isapi_redirect filter added to ISAPI Filters tab is loaded properly on the Web server:

1. Type the File Manager Configuration URL into a browser (using the reverse-proxy web server
alias or hostname and listen port) and make sure the Configuration page loads successfully.

2. Inthe IIS Manager, right-click the Agile PLM Web Site, and choose Properties from the shortcut
menu.

The Agile PLM Web Site Properties dialog box appears.
3. Select the ISAPI Filters tab.

The status for the Jakarta 11S Connector filter shows an arrow pointing up, indicating that it is
loaded on the IIS Web server and ready to proxy all requests to the File Manager.
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Configuring the Apache Web Server as a Proxy Server for
Agile PLM and Agile File Manager

On UNIX operating systems, you can use Apache Web Server as the Web proxy server for Agile
PLM. If you choose the Apache Web Server when you install Agile PLM, you must specify the
Apache Home Directory.

Note If you set up a Web proxy server for Agile File Manager that is different from
the server or port you specified when you installed Agile PLM, you must make
sure that File Manager points to the proxy server on the correct port. For more
information, see “Reconfiguring File Manager After Setting Up a Web Proxy
Server (on page 35)".

Configuring Apache Web Server on Solaris

This section shows how to configure an Apache Web Server 2.0.55 proxy for Agile PLM and Agile
File Manager on Solaris.

Apache Http Server 2.0.x for Solaris:
http://archive.apache.org/dist/httpd/binaries/ (http://archive.apache.org/dist/httpd/binaries/)

Mod_Jk Connector for Apache 2.0:

Download the connector from http://www.apache.org/dist/tomcat/tomcat-
connectors/jk/binaries/solaris/jk-1.2.6/ (http://www.apache.org/dist/tomcat/tomcat-
connectors/jk/binaries/solaris/jk-1.2.6/) or copy the mod_jk-1.2.15-sparc-Solaris8-Apache20.so
file from the AGILE_HOME\AgileProxies directory.

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File Manager on Solaris:

1. Download, build, and install Apache Web Server for Solaris. For installation instructions, refer
to the Apache documentation.

./configure --prefix=/opt/apache2 -enable-mods-shared=all
make

make install

2. Afterinstalling Apache Web Server, install the proxy plug-in:
a. Go to the following directory:

$Apache/modules/proxy
b. Run the following commands:

$Apache/bin/apxs -i -a -c proxy_connect.c
$Apache/bin/apxs -i -a -c proxy_http.c

3. Download the Mod_Jk Tomcat Connector from the URL listed above or copy the mod_jk-
1.2.15-sparc-Solaris8-Apache20.so file from the AGILE_HOME\AgileProxies directory. Save
the connector as $Apache/modules/mod_jk.so.

4. Create a Mod_Jk configuration file ($Apache/conf/workers.properties) with the following
entries:
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7.
8.

worker.list=default
worker.default. type=ajpl3
worker.default.host=<File Manager host name>

worker.default.port=8009

Add the following lines to the $Apache/conf/httpd.conf file:

#Enable Mod_proxy for Application Server Proxying
LoadModule proxy connect_module modules/mod_proxy_connect.so
LoadModule proxy http_module modules/mod_proxy_http.so
#Enable Mod_Jk for File Manager proxying

LoadModule jk_module modules/mod_jk.so

# Add the proxy forward path.Replace appropriately with actual Virtual
# path and server host/port

ProxyPass /Agile http://server:7777/Agile

ProxyPassReverse /Agile http://server:7777/Adile

#Entries for File mgr proxying

JkWorkersFile conf/workers.properties

#Filemgr is virtual path for Agile File Manager
JkMount /Filemgr default
JkMount /Filemgr/* default

If mod_proxy was not compiled into httpd, add the following to the $Apache/conf/httpd.conf file:

LoadModule proxy module modules/mod_proxy.so

Open $Tomcat/conf/jk2.properties and add the following entry: channelSocket.port=8009

The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml.
<Connector port="8009"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" debug="0"
protocol="AJP/1.3" />
Restart Apache Tomcat.
Restart Apache Web Server.
Sapache/bin/apachectl stop
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Sapache/bin/apachectl start

Configuring Apache Web Server on Linux

This section shows how to configure an Apache Web Server 2.0.x proxy for Agile PLM and Agile
File Manager on Linux.

Generally, when you install Red Hat Linux it includes Apache Web Server 2.0 and the
MOD_PROXY Connector. If your Linux server does not have Apache Web Server, you can
download it from the following location:

Apache Http Server 2.0.x for Linux:
http://archive.apache.org/dist/httpd/binaries/ (http://archive.apache.org/dist/httpd/binaries/)

The Mod Jk Connector for Apache Http Server, which is necessary for using Apache as a proxy for
Agile File Manager (Tomcat), can be installed using Red Hat RPM. You can also download the
source from the following location and compile it.

Mod_Jk Connector for Apache 2.0:
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/linux/jk-1.2.14/
(http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/linux/jk-1.2.14/) or contact
Agile Support.

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File Manager on Linux:

1. Open the Apache Web Server $Apache/conf/httpd.conf file and ensure that the following
modules are uncommented:

LoadModule proxy module modules/mod_proxy.so
LoadModule proxy_ connect_module modules/mod_proxy_ connect.so
LoadModule proxy_ http_module modules/mod_proxy_http.so

2. Atthe end of the $Apache/conf/httpd.conf file, add the following ProxyPass and
ProxyPassReverse commands. Replace the hostname, port, and Agile virtual path with
appropriate values for your server.

ProxyPass /Agile http://server:7777/Agile

ProxyPassReverse /Agile http://server:7777/Agile

3. Copy the workers.properties and uriworkermap.properties files from the
AGILE_HOME/AgileProxies directory to the $Apache/conf directory.

4. Replace the following tokens in the workers.properties and uriworkermap.properties files:
@FILE_SERVER_VIRTUAL_PATH@ = File Manager Virtual Path
@FILE-SERVER-HOST@ = Tomcat hostname or IP address

@AJP-PORT@ = Tomcat AJP Protocol port (This port can be found in
Tomcat'’s server.xml file)

5. Add the following lines to the $Apache/conf/httpd.conf file:
LoadModule jk_module modules/mod_jk-1.2.1l4-apache-2.0.54.s0
JkWorkersFile conf/workers.properties

JkMount conf/uriworkermap.properties
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Open $Tomcat/conf/jk2.properties and add the following entry:
channelSocket .port=8009

The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml.
<Connector port="8009"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" debug="0"
protocol="AJP/1.3" />
Restart Apache Tomcat.
Restart Apache Web Server.
Sapache/bin/apachectl stop
Sapache/bin/apachectl start

Configuring Apache Web Server on AIX

This section describes how to configure Apache HTTP Server 2.0.x on AlX as a reverse proxy for
Agile PLM with BEA WebLogic and Agile File Manager with Apache Tomcat.

Download the Apache HTTP Server 2.0.x distribution:

Download the Apache Http Server 2.0.x distribution:
http://archive.apache.org/dist/httpd/

Alternatively, you may be able to find a pre-compiled version of the HTTP server for AlX here:
http://archive.apache.org/dist/httpd/binaries/aix/

Download the Apache Tomcat connector module (mod_jk) for Apache 2.0.x:
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/

Alternatively, you may be able to find a pre-compiled version of the connector for AlX here:
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/aix/

To configure an Apache HTTP Server on AIX as a reverse proxy server for Agile PLM and Agile File Manager:

1.

2.

Download and install (and if necessary, build) Apache HTTP Server for AIX. For instructions,
refer to the documentation included in the Apache distribution.

After installing Apache HTTP Server, install the proxy plug-in:
a. Change to the following directory:

SAPACHE_HOME/modules/proxy
b. Run the following commands:

SAPACHE_HOME/bin/apxs -i -a -c¢ procy_connect.c
SAPACHE_HOME/bin/apxs -i -a -c¢ procy_http.c

Download (and if necessary, build) the Apache Tomcat connector (mod_jk) from the URL
previously listed. Save the connector as $APACHE_HOME /modules/mod_jKk.so.

Create a configuration file (SAPACHE_HOME/conf/workers.properties) for the Apache Tomcat
connector with the following entries:
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worker.list=default
worker.default.type=ajpl3
worker.default.host=<File Manager host name>
worker.default.port=8009
5. Add the following lines to the SAPACHE_HOME/conf/httpd.conf file:
#Enable Mod_proxy for Application Server Proxying
LoadModule proxy connect_module modules/mod_proxy_connect.so
LoadModule proxy http_module modules/mod_proxy_http.so
#Enable Mod_Jk for File Manager proxying
LoadModule jk_module modules/mod_jk.so
#Add the proxy forward path.Replace appropriately with actual Virtual
#path and server host/port
ProxyPass /Agile http://<application server hostname>:7777/Agile

ProxyPassReverse /Agile http://<application server
hostname>:7777/Agile

#Entries for File Mgr proxying

JkWorkersFile conf/workers.properties

#Filemge is the virtual path for Agile File Manager
JkMount /Filemgr default

JkMount /Filemgr/* default

6. If mod_proxy was not compiled into httpd, add the folliwng line to the
$APACHE_HOME/conf/httpd.conf file:

LoadModule proxy _module modules/mod_proxy.so
7. Edit the file $STOMCAT_HOME/conf/jk2.properties and add the following entry for the AJP port:
channelSocket .port=8009

The AJP Port specified above must match the AJP port specified in
$TOMCAT_HOME/conf/server.xml.

<Connector port="8009"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" debug="0"
protocol="AJP/1.3" />
8. Restart Apache Tomcat.
9. Restart Apache HTTP Server.
SAPACHE_HOME/bin/apachectl stop
SAPACHE_HOME/bin/apachectl start
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Enabling Debugging Information for the Jakarta Tomcat Connector

To troubleshoot problems with the Apache Web Server proxy for Agile File Manager, you can save
debugging information for the Jakarta Tomcat Connector.

To save debugging information for the Jakarta Tomcat Connector:

1. Open the $Apache/conf/httpd.conf, and add the following lines (after the JkMount setting):
JkLogFile "logs/mod_jk.log"
JkLogLevel debug

2. Save the file.
3. Restart Apache Web Server.

Open the log file and check for errors.

Logging In to the Agile Web Client

Use the following URL to test the Agile Web client setup:

1. Start the Agile Server.
a. Windows: Choose Start > All Programs > Agile > Agile 9.2.2.4 > Start Agile Server to start the Agile
server, if it is not installed as a Windows service.
UNIX: Run the StartAgile.sh script located in the /opt/Agile/Agile9224/agileDomain/bin
directory
b. A Command Prompt window appears. This window must remain open, but can be
minimized, for users to access the Agile Web client.
Wait until the following message appears in the command window: “Agile PLM Server
Starting Up”.
2. Open your browser and go to the following URL to test the Agile Web client setup:

http://WebServer hostname:port/virtual path/PLMServlet

Note The URL is case-sensitive. The default virtual path name is Agile.
The login window for the Agile Web client appears in the browser.

Note If you need to stop the Application Server, close the Command Prompt window
or choose Start > All Programs > Agile > Agile 9.2.2.4 > Stop Agile Server.

Troubleshooting the Agile Web Client

This section provides the basics for troubleshooting the Agile Web client and Web server issues.
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Confirming Accessibility

Confirm that the following connections are valid:

@ Ping the Agile Application Server computer to make sure it is accessible from the Agile Web
proxy computer and that the specified port is available.

@ Make sure the web server is up and running on the specified ports, and that the specified DNS
hostname is valid and registered for external accessibility by the Agile Web client browsers.

URL Error Messages

If you specify this URL in the browser and receive the message “Page not found,” check the
following:

o Make sure that the IIS Web server is accessible.

= Open the iisproxy.ini file and make sure the client virtual path name is the same as the login
URL for the Agile Web client.

@ Make sure the Agile Viewer has started on the host computer.

If the following error message appears:

“Servlet tunneling to AgileViewServerHost:5099 (IP=x.x.x.x) Connection state: ERROR”

o Check to see if the Agile Viewer hostname specified during the installation is correct and the
port number is available. The information on the Agile Viewer hostname and port number is
specified in the web.xml file.

o Make sure the Agile Viewer-specific ports are open from DMZ firewall to the internal firewall.

Customized Virtual Path Does Not Work

Check the iisforward.dll and iisproxy.dll files in the AGILE_ HOME\AgileProxies folder where the
iisproxy.ini file is located. You may need to delete the settings you specified in “Configuring 1IS as a
Proxy Server for Agile PLM” and set them up again. Then stop and restart the IS Admin and
Worldwide Web services.

Browser Shows A Proxy Timeout Message

The proxy has a timeout default value of 1500 seconds. If you frequently see this message, you
should increase the timeout value to a larger value.

To change the proxy timeout:

1. Openthe AGILE_HOME\AgileProxies\iisproxy.ini file.

2. Change or add the following line:
ConnectTimeoutSecs=1500
ConnectRetrySecs=value must equal ConnectTimeoutSecs

HungServerRecoverSecs=value greater than ConnectTimeoutSecs
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Log Files (Disk Space)

There are two log files for the Agile Web client:
= Proxy log
= Web client log

If all log files are on, disk space can fill quickly. You may need to clean up the log files or turn
logging off.

For the proxy log file:

Open the AGILE_HOME\iis\iisproxy.ini file and remove either of the following lines:
Debug=on
Debug=ALL

For the Agile Web client log file:
1. Open the AGILE_HOME\agileDomain\config\log.xml file.
2. Change the <priority value="debug" /> line to <priority value="error" />.

3. Delete all files with a LOG extension appearing in the AGILE_HOME\agileDomain\config
folder.

Connection Refused or Server is Busy Error Message

TCP connections can be buffered in a wait queue, which has a default value of 50. To increase this
value, open AGILE_HOME\agileDomain\config\config.xml and increase the wait queue attribute
value by 25 percent until the messages no longer appear.

Changing the Password for the Agile Domain

Changing the password from console changes only the WebLogic password. The Agile Web client
uses a password that is specified during installation. This password cannot be changed in
WebLogic.
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Configuring the Microsoft Excel-based Client
for Agile PG&C

This chapter includes the following:
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Overview of the Microsoft Excel-based Client for Agile
PG&C

Important Configuration steps described in this chapter apply only to customers who have purchased Agile
Product Governance & Compliance.

Agile Product Governance & Compliance (PG&C), one of the Agile PLM product solutions, is
designed to help manufacturers audit the presence and amount of regulated substances used in
their products, and to demonstrate that they responsibly dispose of, recycle, or reuse parts
containing those substances. Agile PG&C includes built-in support for the Microsoft Excel-based
client for OEM manufacturing regulations, including the Japan Green Procurement Survey
Standardization Initiative (JGPSSI), and substances and weights rollups.

Important Although Agile provides two Microsoft Excel templates for Agile PG&C, the solution is
extensible. You can develop other Microsoft Excel templates to handle other Declaration
classes your company has defined. For information about how to develop Microsoft Excel
templates for use with Agile PG&C, contact your Agile Solutions Delivery representative.

Important After installing Agile PLM, if any of the changes detailed in this chapter are required for
your Excel integration, the correct sequence is: (a) stop the application server(s); (b)
undeploy; (c) make the changes in <standard Agile PLM Install folder> > application.ear; (d) re-
deploy; and (e) re-start the servers.
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JGPSSI Support

JGPSSI has created a standardized digital form that companies can use to inquire about the
chemical substances contained in parts and materials they procure in Asia. For more information
about JGPSSI, see the Japan Electronics and Information Technology Industries Association Web
site:

http://home.jeita.or.jp/eps/greenTOP-eg.html (http://home.jeita.or.jp/eps/greenTOP-eg.html)

JGPSSI uses Microsoft Excel tools for collecting information about substances contained in
assemblies for Japanese Green Procurement. Agile provides a flexible and reusable integration
between Agile PG&C and Microsoft Excel that allows customers to use the JGPSSI spreadsheet
without modification, and then upload the information to Agile PG&C after validation.

Note Agile PLM supports the JGPSSI survey tool (a Microsoft Excel template)
version 2.02.

Agile PLM supports a Japanese-language template of the JGPSSI spreadsheet. The
Japanese-language templates are only available to customers who have purchased the
Japanese Server License. Also, the administrator must set users’ Language and Encode
user preferences to the appropriate setting to work in that language in the Agile clients’
user interfaces. Please contact Agile Solutions Delivery for more information.

Substances and Weights Rollups

You can use Microsoft Excel to perform analysis of the Bill of Substances (BOS) information for an
assembly. Using the Actions menu command Rollup in Excel, the integrated Excel spreadsheet can
roll up the substances and weights for the top-level assembly.

Note Agile PLM supports a Japanese-language template of the Substances and
Weights spreadsheet.

PLM also supports localized versions in Chinese, French, and German of the Substances
and Weights Rollup feature used in Microsoft Excel-base Client. However, the localized
template does not work for these languages out-of-the-box, the template must be adjusted
by Oracle Consulting-Agile Practice.

The Japanese-language templates are only available to customers who have purchased
the Japanese Server License. Localized versions also need appropriate License Key. Also,
the administrator must set users’ Language and Encode user preferences to the
appropriate setting to work in that language in the Agile clients’ user interfaces. Please
contact Oracle Consulting-Agile Practice for more information.

Client Software Requirements
The Microsoft Excel-based client for Agile PG&C requires the following client-side software:
Operating System

B Windows 2000 Pro SPX
@ Windows XP Pro SP2
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@ Windows 2003 Pro SP1

Client Applications

o Microsoft Excel 2000, Microsoft Excel XP, or Microsoft Excel 2003 Pro SP1

= Microsoft Internet Explorer 6.0

For complete Agile PLM software requirements, see the Agile PLM Capacity Planning and
Deployment Guide.

Microsoft Excel-based Client FAQ

This section answers some common questions about the Microsoft Excel-based client for Agile
PG&C.

How does the Microsoft Excel-based client work? What is the underlying technology used to integrate with
Agile PG&C?

The Microsoft Excel-based client uses the following technology:

= Agile PLM Process Extensions — Agile Web Client launches the Microsoft Excel-based client
through process extensions (PX), which are programs that extend the functionality of the client
interface.

o Agile PLM ActiveX Control — an Internet Explorer plugin that monitors use of the Microsoft Excel-
based client and downloads and uploads data from the Agile PLM server as requested by the
client.

o HTTP, HTTPS, or SMTP — standard protocols used to move data between the server and the client
= Microsoft Excel — spreadsheet client with its own client-side business logic.
Other than Microsoft Excel, is any other client software required for the Microsoft Excel-based client?

The Agile PLM ActiveX Control, an Internet Explorer plugin, is required. It's downloaded and
installed automatically the first time a user launches the Microsoft Excel-based client from Agile
Web Client. Of course, Internet Explorer 6.0 is also required, as well as a Windows operating
system.

What Microsoft Excel templates does Agile PG&C provide by default?

There are two Excel applications provided out-of-the-box with Agile P&C:
= JGPSSI Declaration application — supports Japanese Green Procurement

@ Rollup In Excel application — calculates substances and weights rollups for top-level assemblies
Can | create new Microsoft Excel templates for use with Agile PG&C?

Yes, the solution is extensible. For information on how to develop Microsoft Excel templates for
Agile PG&C, contact your Agile Solutions Delivery representative.

Can | create Microsoft Excel templates for use with other Agile PLM solutions, such as Product Collaboration?

No. Currently, only Declaration classes and their subclasses are supported. Other classes may be
supported in future Agile PLM releases.
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Can | use the Firefox browser to launch the Microsoft Excel-based client?
No. Only Microsoft Internet Explorer 6.0 is supported.
Must | be logged into Agile Web Client to use the Microsoft Excel-based client for Agile PG&C?

No. You can use the Microsoft Excel-based client synchronously (that is, by opening a spreadsheet
from Agile Web Client) or asynchronously (that is, by opening a spreadsheet attached to an email
message).

How do I launch the Microsoft Excel-based client from Agile Web Client?

Process extensions are used to launch the Microsoft Excel-based client. The process extension for
launching JGPSSI-in-Excel is initiated from the Actions menu of JGPSSI declarations. The process
extension for launching Substances and Weights rolllup in Excel is initiated from the Actions menu of
items. For information about developing process extensions, see the Agile SDK Developer Guide.

Can | sign the Agile PLM ActiveX Control with my company’s certificate?

Yes. See “Digitally Signing the Agile PLM ActiveX Control (on page 64)”.

Does the Microsoft Excel-based client require any special authentication?

The Microsoft Excel-based Client uses the same credentials that you use to log into Agile Web
Client, and it prompts you to log into a separate Agile PLM session when you choose Agile > Submit
Response or Agile > Open Request.

Where does the client-side business logic for the Microsoft Excel-based client reside?
Client-side business logic resides entirely in the Microsoft Excel template.
How does the Microsoft Excel-based client handle notifications for Declarations?

Agile PLM provides four system-generated notifications related to the Microsoft Excel-based client:

o Declaration Excel Submit Success Supplier Notification — notification sent to the supplier to confirm
successful submission of a Declaration.

o Declaration Excel Submit Import Failure — notification sent to the compliance manager or originator
to inform him that the submitted Declaration failed to be processed on the server due to import
problems.

@ Declaration Excel Submit Failure — notification sent to the compliance manager or originator to
inform him that the submitted Declaration failed to be processed on the server due to an
exception.

o Declaration Excel Submit Failure Supplier Notification — notification sent to the supplier to inform him
that the Declaration failed to be submitted due to import errors.

Each notification includes text for the subject and body of a message. The Agile PLM administrator
can modify these notification messages.

To customize these natifications, start the Agile Java Client and log in as an administrator user.
Click the Admin tab, and choose System Settings > Notifications > Declaration Notifications. Microsoft
Excel-based client notifications are listed under “Declaration Miscellaneous Notifications.”

For more information about Agile PLM notifications, see the Agile PLM Administrator Guide.
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What languages does the Microsoft Excel-based client support?

The JGPSSI and Rollup in Excel standard templates support English only. Other templates can be
developed to support other languages.

Microsoft Excel-based client messages and captions support all languages supported by Agile PLM
9.2.2.4. Additionally, the menus of Microsoft Excel templates can be customized for different
languages.

Does the Microsoft Excel-based client use VBA macros?

The Microsoft Excel templates provided for Agile PG&C do not use VBA macros. Although you are

not prevented from developing a Microsoft Excel template that uses VBA macros, antivirus software
may prevent the macros from running, and you should set the security level in Microsoft Excel to at
least Medium (choose Tools > Macro > Security).

Configuration Sequence

To enable support for the Microsoft Excel-based client for Agile PG&C, you must perform the
following manual configuration steps after Agile PLM has been installed:

1. Set up privileges for Agile PG&C objects (such as Substances and Declarations).

2. Enable specific attributes in PG&C-related classes to ensure the Microsoft Excel-based client
functions correctly.

3. Restrict Declaration names to 50 characters for every class that you are enabling the Microsoft
Excel-based client.

4. Obtain a production license for the Agile PLM ActiveX Control from your Agile Account
Executive and deploy the related files on the Agile Application Server.

Optionally, digitally sign the Agile PLM ActiveX Control.

Use Agile Java Client to set the Allow Download of Productivity Components preference to Yes.
This allows Agile Web Client users to download the Agile PLM ActiveX Control from the server.

Install the Agile PLM ActiveX Control.
Test that the Microsoft Excel-based client for Agile PG&C works properly.

Setting Privileges for Agile PG&C Objects

This section describes how to set privileges for Agile PG&C objects. If you don't ensure that
privileges are properly set, you may not be able to move data from the JGPSSI spreadsheet into
Agile PLM and vice versa.

© N

To set privileges for Agile PG&C objects:

1. Log into Agile Java Client as a user with Administrator privileges.
2. Click the Admin tab.

3. Choose User Settings > Privileges.

4

Open the following privilege masks, and for each one click the drop-down arrow next to the
Applied To field and add the following attributes:
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Privilege Mask

Attributes to Add to the Applied To Field

Read Substances

Modify Substances

Modify Supplier
Created Declarations

Read Declarations

Read My Open and
Submitted Declarations

Read Supplier Created
Declarations

Modify Declarations

Modify My Open
Declarations

Substances.Page Two.Text01

Substances.Page Two.Text25

Declarations.Page Two.Text02, Text03, Text08 —
Text10, Text14, Text19 — Text21

Declarations.ltems.Date01
Declarations.ltems.List01 - List03
Declarations.ltems.Text01 - Text09
Declarations.Manufacturer Parts.Date01
Declarations.Manufacturer Parts.List01 - List03
Declarations.Manufacturer Parts.Text01 - Text09
Declarations.Part Groups.Date01
Declarations.Part Groups.List01 - List03
Declarations.Part Groups.Text01 - Text09

Declarations.Page Two.Text14, Text19 — Text21
Declarations.ltems.Date01
Declarations.ltems.List01 - List03
Declarations.ltems.Text01 - Text09
Declarations.Manufacturer Parts.Date01
Declarations.Manufacturer Parts.List01 - List03
Declarations.Manufacturer Parts.Text01 - Text09
Declarations.Part Groups.Date01
Declarations.Part Groups.List01 - List03
Declarations.Part Groups.Text01 - Text09

After modifying the Applied To field for each of the privilege masks listed above, Click OK.

To save the privilege mask, click Save.

Click Close.
Click Close.

Enabling Attributes that are Required for Excel Rollups

The following attributes must be enabled (Visible property is set to Yes for each attribute) at the
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class level for the Microsoft Excel-based client to function correctly.

Classes: Parts, Manufacturer Parts, and Documents

Compliance Tab > Composition Table

@ Specification Name
o Declaration Name
@ Declared Weight

o Supplier

Compliance Tab > Substances Table

@ Child Level

@ Substance Name
= Substance Type
= Mass

o Declared PPM

@ CAS Number

@ Conversion Factor

Classes: Parts and Documents
BOM Tab

o Item Number
= Item Description

= Item Rev (Item Revision)

= Qty (Quantity)
Manufacturers Tab

o Mfr. Part Number
o Mfr. Part Description

g Mfr. Name

Restricting the Length of Declaration Names

Agile’s Microsoft Excel-based client requires Declaration names to not exceed 50 characters. If a
Declaration has a name longer than 50 characters, you might not be able to open it in Microsoft

Excel.
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To avoid potential problems opening Declarations with long names, you should restrict Declaration
names to 50 characters for every class that you are enabling the Microsoft Excel-based client. You
can do this by making autonumbers required (assuming that each number in the autonumber
sequence does not exceed 50 characters) or by adjusting the maximum length of the Cover Page >
Reference Number attribute.

To make autonumbers required for a Declaration subclass:
1. Log into the Agile Java Client as an administrator.
2. Click the Admin tab.

3. Under Data Settings, double-click Classes.

4

Open a Declaration subclass that has enabled the Microsoft Excel-based client (for example,
JGPSSI Declaration).

Select the General Information tab.

In the Autonumber Required list, select Yes.
In the Autogenerate list, select Yes.

Click Save.

© N o u

To adjust the maximum length of Declaration names:
1. Log into the Agile Java Client as an administrator.
Click the Admin tab.

Under Data Settings, double-click Classes.

A wDn

Open a Declaration class that has subclasses that have enabled the Microsoft Excel-based
client (for example, JGPSSI Declarations).

Click the User Interface Tabs tab.
double-click Cover Page.
Click the Attributes: Cover Page tab.

double-click the Reference Number attribute.

© © N o U

Set the MaxLength property to 50 or less.
10. Click Save.

Deploying License Files for the Agile PLM ActiveX
Control

To enable support for the Microsoft Excel-based client for Agile PG&C, you must obtain a valid
license for the Agile PLM ActiveX Control, an Internet Explorer plugin. This license is specific to the
server on which the Agile Application Server is installed. To obtain the license file (license.xml) and
a properties file (properties.js), contact your Agile Account Executive.

After you obtain the license file and properties file, you need to deploy the files on the Agile
Application Server.
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Note If you have an application server cluster, you must deploy the Agile PLM

ActiveX Control license files on the Respository Host server for Oracle
Application Server or the Administration Server for WebLogic Server. The
application server will then propagate the license files to other servers in the
cluster.

To deploy license files for the Agile PLM ActiveX Control:

1. Stop the Web proxy server.

2. Stop the Agile Application Server.

3. Windows: On the application server computer, open a command prompt window.

UNIX: On the application server computer, open a terminal window and log on as the user who
installed the Agile Application Server.

4. Expand the Agile application.ear file:
Windows: \AGILE_HOME\install\bin\ExtractArchive.cmd
UNIX: /AGILE_HOME/install/bin/ExtractArchive.sh
5. Copy the license.xml and properties.js files that you received from Agile to the following location:
\AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWarnambassador
6. Repack the Agile application.ear file:
Windows: \AGILE_HOME!\install\bin\RepackArchive.cmd
UNIX: /AGILE_HOME/install/bin/RepackArchive.sh
7. Undeploy the Agile application, and then redeploy it.
Windows:
\AGILE_HOME\agileDomain\bin\UnDeployAgilePLM.cmd
\AGILE_HOME\agileDomain\bin\DeployAgilePLM.cmd
UNIX:
IAGILE_HOME/agileDomain/bin/UnDeployAgilePLM.sh
IAGILE_HOME/agileDomain/bin/DeployAgilePLM.sh
8. Start the Agile Application Server.
9.  Start the Web proxy server.

Using the Developer Version of the Microsoft Excel
Integration License File

If you are developing or testing Microsoft Excel templates for Agile PLM Declaration classes, you
can use the developer version of the Microsoft Excel integration license file that is installed with the
Agile PLM server. The developer license for the Agile PLM ActiveX Control provides the same
functionality as the production license. However, when you install it, a warning message appears:
“An UNTRUSTED web site is trying to use Agile PLM ActiveX Control to control your desktop.” Click
Yes in the warning dialog box to continue installing the control.
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Digitally Signing the Agile PLM ActiveX Control

The first time you choose one of the commands that launch the Microsoft Excel-based client (such
as Actions > Open In Excel) in Agile Web Client, the Agile PLM ActiveX Control is automatically
downloaded and installed on your computer. For security reasons, Internet Explorer requires that
software it downloads must have a digital signature. A digital signature lets you verify the contents
of a file and ensures that it comes from a trusted source.

When you install Agile PLM, the Agile PLM ActiveX Control is already digitally signed from Agile
Software. You can choose to use your company’s own digital signature for the control instead. If
you use your company’s digital signature, each time a user of your Agile PLM system downloads
the Agile PLM ActiveX Control it will be recognized as coming from your company and not from
Agile Software.

You provide a digital signature by purchasing a certificate from a certificate authority. A certificate
authority is an entity that issues digital certificates for use by other parties. Examples of certificate
authorities are Verisign

(http://www.verisign.com/ (http://www.verisign.com/)) and CAcert (http://www.cacert.org/
(http://www.cacert.org/)).

For more information about digital signatures, go to the MSDN site (http://msdn.microsoft.com/
(http://msdn.microsoft.com/)) and search for “Digitally Signing ActiveX Components”.

To digitally sign the Agile PLM ActiveX Control:

1. Stop the Web proxy server.

2.  Stop the Agile Application Server.

3. Windows: On the application server computer, open a command prompt window.

UNIX: On the application server computer, open a terminal window and log on as the user who
installed the Agile Application Server.

4. Expand the Agile application.ear file
Windows: \AGILE_HOME\install\bin\ExtractArchive.cmd
UNIX: /AGILE_HOME/install/bin/ExtractArchive.sh
5. Digitally Sign the agileambassador.cab file found in the following location:
\AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWarnambassador
6. Repack the Agile application.ear file
Windows: \AGILE_HOME\install\bin\RepackArchive.cmd
UNIX: /AGILE_HOME/install/bin/RepackArchive.sh
7. Undeploy the Agile application, and then redeploy it.
Windows:
\AGILE_HOME\agileDomain\bin\UnDeployAgilePLM.cmd
\AGILE_HOME\agileDomain\bin\DeployAgilePLM.cmd
UNIX:
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IAGILE_HOME/agileDomain/bin/UnDeployAgilePLM.sh
/AGILE_HOME/agileDomain/bin/DeployAgilePLM.sh

8.  Start the Agile Application Server.

9. Start the Web proxy server.

Enabling Downloading of Productivity Components

The Agile PLM ActiveX Control is a plugin for Microsoft Internet Explorer that users can download to
their client machines. To enable downloading of the Agile PLM ActiveX Control from the server, the
Agile PLM administrator must log into the Agile Java Client and make sure the Agile PLM
preference named Allow Download of Productivity Components is set to Yes. Otherwise, users won't be
able to download the ActiveX control and use the Microsoft Excel-based client.

Note The Agile PLM ActiveX Control is supported only on the Microsoft Internet
Explorer browser. You cannot use it with other browsers, such as Firefox.

To enable downloading of the Agile PLM ActiveX Control:

Log into Agile Java Client as a user with Administrator privileges.

Click the Admin tab.

Choose Server Settings > Preferences.

For the Allow Download of Productivity Components preference, select Yes.
Click Save.

a > w N e

For more information about setting Agile PLM preferences, see the Agile PLM Administrator Guide.

Installing the Agile PLM ActiveX Control

If you enable downloading of the Agile PLM ActiveX Control (see the previous section), the plugin is
installed automatically on the client computer when you choose a command (such as Actions > Open
In Excel) that launches the Microsoft Excel-based client. Separate installation of the plugin is
unnecessary.

Some companies have strict security procedures that prohibit users from installing ActiveX controls
automatically onto their desktop computers. If that is the case with your company, your IT
department can install the Agile PLM ActiveX Control by downloading an installer for the plugin from
the Agile Support site

(http://support.agilesoft.com (http://support.agile.com)).

Testing the Microsoft Excel-based Client for Agile PG&C

This section describes how to test whether the Microsoft Excel-based client works properly.

To test JGPSSI Declarations:
1. In Agile Web Client, choose Create > Declarations > JGPSSI Declarations.

2. Specify a supplier. Also, make sure the Continue Creation in Wizard box is checked. Click
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Continue.

In the Compliance Manager field, select a user who is a compliance manager.

In the Workflow field, select Default Declarations. Click Next.

On the Add Specifications page, click Next.

On the Add Items page, click Add to add an item. Type an existing item number and Click OK.
Click Finish.

Choose Actions > Open in Excel. After a moment, a Security Warning dialog box appears.

© N o 0~ w
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9. Make sure the Always trust content from Agile Software Corporation box is checked. Click Yes to
install and run the Agile PLM ActiveX Control (also called Agile Ambassador).

10. After a moment, Microsoft Excel is launched and a file with the name declaration_number.xls
is opened. You are prompted to save the file to a folder on your desktop called Agile
Spreadsheet Files. Click Save.

11. Close Microsoft Excel and return to Agile Web Client.
12. For the new JGPSSI Declaration you created, click Next Status to open it to the supplier.
13. Select users to notify, and Click OK.

14. Click the Exit ':m button to log out.

15. Click Login. Log in as a contact user for the supplier associated with the JGPSSI Declaration.
16. Click the link to the JGPSSI Declaration to open it.

17. In the Navigation pane, click Open In Excel.

18. After a moment, Microsoft Excel is again launched and the same file as earlier is opened. You
are prompted to save the file to a folder on your desktop called Agile Spreadsheet Files. You
already saved it earlier, so click Cancel.

Page - 66 Agile Product Lifecycle Management



Chapter 8

19. Fillin a one or more fields on the sheet. For example, change the value of the Parts Mass
field.

20. Save the Microsoft Excel file.

21. Choose Agile > Submit Response. You need to log in at this point. The Submit Response window
appears.

22. Type your approval password, and click Submit.

23. After your response is uploaded, a message box appears: “The declaration has been submitted
for processing. Updates may not be immediately visible in the Agile system.” Click OK.

To test Substances and Weights Rollups:
1. In Agile Web Client, open a part that is a top-level assembly with multiple substances.
2. Choose Actions > Rollup in Excel.

3. Select the specification that is used for the composition, and Click OK. The Excel file with the
same filename as the part number appears.

4. Inthe Excel file, choose Agile > Run Scenario. The rolled-up amounts for materials and
substances used in the assembly are displayed.

Troubleshooting

This section provides solutions to problems you may encounter in configuring the Microsoft Excel-
based client for Agile PG&C.

Import and Error Logs
Import and error logs for the Microsoft Excel-based client can be found in the server's Temp folder.
On Windows 2000/2003 servers, the Temp folder is usually found at

C:\Documents and Settings\<current_logged_in_user>\Local Settings\Temp\AgileEITemp

or
C:\Winnt\Temp\AgileEITemp

If you are unsure where to find the Temp folder, open a Command Prompt window and type the
following command:

cd %$temp%$\AgileEITemp
On UNIX servers, the Temp directory is usually found at

Ivaritmp/AgileEITemp

The most recent folder under AgileEITemp contains data and import or error logs of the last
submission done in Excel

Runtime error

When you choose any command that launches the Microsoft Excel-based client (such as Actions >
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Open In Excel) in Agile Web Client, a Runtime Error window appears.
Solution:

The license files for the Agile PLM ActiveX Control, which are located on the Agile Application
Server, are invalid. Please contact Agile Support to request new license files. Once you receive the
files, you must deploy them on the application server. See “Deploying License Files for the Agile
PLM ActiveX Control (on page 62)".

This feature has not been enabled by the application administrator

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the
popup window reads, “This feature has not been enabled by the application administrator.”
Consequently, the Agile PLM ActiveX Control could not be downloaded.

Solution:

In the Agile Java Client, set the Agile PLM preference Allow Downloading of Productivity Components to
Yes. See “Enabling Downloading of Productivity Components (on page 65)”".

The page cannot be displayed

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the
popup window reads, “The page cannot be displayed.”

Solution:
Make sure the Web proxy server is running.
Instead of opening a Microsoft Excel file, Agile Web Client login page appears in another window

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the
Microsoft Excel file doesn't appear and instead a new browser window opens with Agile Web Client
login page.

Solution:

= Make sure Agile Web Client login page you're using has the fully qualified domain name for the
server in the URL. For example, if the fully qualified domain name of the server is
“plm.mycompany.com”, Agile Web Client login page URL should look like this:

http://plm.mycompany.com/Aqgile/PLMServlet

@ Make sure the Agile PLM ActiveX Control license file (license.xml) uses a fully qualified domain
name for the Agile Application Server.

The Open In Excel pop-up window appears and then closes, but Microsoft Excel doesn’t launch

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the
Open In Excel pop-up window appears for a few seconds, and then it closes without launching
Microsoft Excel.

Solution:

The Declaration you're trying to open has a very long name. Choose Actions > Save As to save the
Declaration with a name that is 50 characters or less.

To avoid this problem, restrict Declaration names to 50 characters. See “Restricting the Length of
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Declaration Names (on page 61)”.

The Actions menu does not include commands to launch the Microsoft Excel-based client

When you open an Item in Agile Web Client, the Rollup in Excel command isn't available on the
Actions menu. When you open a JGPSSI Declaration in Agile Web Client, the Open In Excel, Import
JGPSSI, and Export JGPSSI commands aren’t available on the Actions menu.

Solution:

The Agile PG&C process extensions have not been assigned to Agile PLM classes. The Agile
PG&C process extensions are assigned automatically to classes when Agile PLM is installed, but
perhaps the Administrator modified the classes and inadvertently unassigned the Agile PG&C
process extensions.

Here is how the Agile PG&C process extensions should be assigned:

@ The Rollup In Excel process extension must be manually assigned to the Items classes, that is,
Parts and Documents.

= The Open In Excel, Import JGPSSI, and Export JGPSSI process extensions should be automatically
assigned to the JGPSSI Declarations class. Please verify that this was accomplished; if they
did not load, it needs to be done manually.

For information on how to assign process extensions to classes, see the Agile PLM Administrator
Guide.

The cell or chart you are trying to change is protected and therefore read-only

When you open a JGPSSI Declaration in Microsoft Excel and try to edit one of the cells, you see the
following error message: “The cell or chart you are trying to change is protected and therefore read-
only. To modify a protected cell or chart, first remove protection using the Unprotect Sheet
command (Tools menu, Protection submenu). You may be prompted for a password.”

Solution:

The colored cells of the JGPSSI template (such as headings) are protected and cannot be edited.
You should edit only unshaded (white) cells.

Microsoft VBScript runtime error 1B6: Object doesn't support this property or method

When you choose any command that launches the Microsoft Excel-based client (such as Actions >
Open in Excel) in Agile Web Client, an error message appears: “Microsoft VBScript runtime error
1B6: Object doesn't support this property or method.”

Solution:

Internet Explorer had problems downloading the digital certificate for the Agile PLM ActiveX Control.
Click OK in the error message box to continue.

The problem may be due to a comma in the Company field of the digital certificate. If there isn't a
comma in the Company field, you may need to update your Internet Explorer browser with the latest
patch from Microsoft.

You must restart your computer before the new settings will take effect

When you choose any command that launches the Microsoft Excel-based client (such as Actions >
Open in Excel) in Agile Web Client, a message box appears: “You must restart your computer before
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the new settings will take effect. Do you want to restart your computer now?”
Solution:

You have a previous version of the Agile PLM ActiveX Control installed, and Microsoft Excel is
currently open, so the control cannot be updated. To install the new control, close Excel, and then
click No in the message box (to not restart the computer). Choose Actions > Open in Excel again.
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Configuring Agile Product Portfolio
Management

This chapter includes the following:

B OVBIVIBW .ooeoereeeser R 71

5 PPM POSEUPGrate ULIILY ....c.coovceeiiicsceesse et 71

= Running the PPM Post UPgrade ULIlIY ..........cccoiereiiniesseseissee et sesssesssnens 72
Overview

Agile Product Portfolio Management (PPM) gives you powerful capabilities to define, analyze, and
manage all aspects of a project or program. In Agile PLM 9.2.2.4, some of the business rules have
been changed. These changes impact the data you have already created because the
computations were based on previous rules. During an upgrade from a previous version of PPM,
data migration is necessary in order for the existing data to comply with the new business rules.

To facility the data migration, a post upgrade utility has been developed.

Note The PPM post upgrade utility is NOT supported on WebSphere Application
Server.

PPM Post Upgrade Utility

The PPM Post Upgrade utility was developed to address the following changes in Agile PLM:

= Identifies all resource pool assignments where actual hours are greater than zero and sets the
actual hours value to zero.

o Identifies the leaf tasks that have an incorrect percent complete value, corrects the value, and
then correctly rolls up the value on the parent task.

o |dentifies the tasks where estimated dates should be corrected based on the new business
rules:

a. If one of the estimated dates for a leaf task is null, it will be automatically populated, based
on the other estimated date, only if the other date is not null.

b. The estimated date is rolled up to the parent task considering the schedule date of the
child task, if the child's estimated date is null.

o |dentifies all tasks that have an incorrect value for Actual Time and corrects them.
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Running the PPM Post Upgrade Utility

The utility is installed after you have upgraded your system to Agile PLM 9.2.2.4. The files are
located at AGILE_HOME/agileDomain/tools/922PPMPostUpgradeUtility.zip

Important This utility should be run on the machine where Agile PLM 9.2.2.4 is installed.

To run the PPM Post Upgrade Utility:
1. Unzip the utility files to a temporary directory.

2. Change to the directory where you have unzipped the files and locate the upgrade.properties
file.

3. Edit the following entries in the upgrade.properties file to match your environment:

Server Settings
server.url URL of the Agile PLM 9.2.2.4 application
The format is <protocol>://<machine_name>/<application_name>.
On OAS, the protocol should be ormi. On WebLogic, the protocol should be t3.
server.login.id Login ID of the Agile user who has PPM-related privileges to run the utility, typically the
admin user.
server.login.password Password of the Agile user.
pe.weekend.days Weekends configured in the server. This value should be the same as the setting in the

agile.properties files.

Database Settings

db.url JDBC this driver URL of the database.

The format is jdbc.oracle:thin@<db_machine_name>:<port>:<instance_name>

db.username Agile database username

db.password Agile database password

Application Server Settings

agile.dir The parent directory where the library files for the Agile application are located.
ocdj.dir Location of the Oracle Application Server, if installed.
wls.dir Location of the BEA WebLogic Application Server, if installed.

Verify that the Agile PLM 9.2.2.4 application is running.

On a command line, make sure that the JAVA_HOME environment variable points to the
location of the JDK. If it does not, set the value to the correct location.

6. In the directory where you unzipped the utility files, run install.cmd to start the utility.

Important If you configured the PPM Post Upgrade Utility in Agile PLM 9.2.2 and are upgrading to
Agile PLM 9.2.2.4, run install upgrade-actualtime.cmd, NOT install.cmd to start the utility.

7. Restart the Agile application server.
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Chapter 10
Installing and Configuring Agile Java Client

This chapter includes the following:

= Agile Java ClIent REQUIFEMENES. .....vcuevieeriiresireeeeisesessisersess st sssess s esssssss s sesessssess s sss s s ss s ssnsssessssesasanes 75
= Installing the Agile JAVA ClIENL.........cccvrierieerces st 75
= Reconfiguring Java ClIeNt INLP FIlES ......c.cvviriiericiiriies et 76
= Opening MUIIPIE JAVA CHENTS ...ttt bbb bbb 78

Agile Java Client Requirements

All users need to install JRE 6.0 to use Agile Java Client. JRE 6.0 is available at:

http://java.sun.com/javase/downloads/index.jsp (http://java.sun.com/javase/downloads/index.jsp)
The server-side deployment files for Agile Java Client are installed with the Agile Application Server.

Note The Agile PLM administrator must send users the URL to connect to the
Agile Java Client.

Installing the Agile Java Client

To use the Agile Java Client, you must have the Java Runtime Environment (JRE) version 6
installed on your client computer. Agile Java Client uses Java Web Start technology to download
the software and keep it updated.

To install the Agile Java Client:

1. Open your browser and type the following:
http://Web Server.<domain>:<port>/JavaClient/start.html
For example, the URL might look something like this:
http://plmserver.mycompany.com/JavaClient/start.html

2. Click Launch.

Java Web Start proceeds to download Java Client files and install them on your computer. This
may take a few minutes.

If a Security Warning dialog box appears, click Start.

If the Agile 9.2.2.4 Desktop Integration dialog box appears, click Yes to integrate the Agile Java
Client with your desktop.

You are prompted to log in to the Agile server.

5.  Enter your Agile PLM username and password, and then Click OK.
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The main Agile Java Client window opens.

Running Agile Java Client 9.0 and Agile Java Client 9.2.2.4 on the Same
Computer

Agile Java Client 9.0 and Agile Java Client 9.2.2.4 require different versions of the Java Runtime
Environment (JRE). Agile Java Client 9.0 requires JRE 1.4.2, whereas Agile Java Client 9.2.2.4
requires JRE 6.0.

If you have both JRE 1.4.2 and JRE 6.0 installed on the same computer, you need to configure the
Agile 9.0 application in Java Web Start to disable JRE 6.0. Otherwise, you will experience
problems. For example, you won’t be able to add files to the Attachments tab of an object.

To force Agile Java Client 9.0 to use JRE 1.4.2:

1. Go to the directory where JRE 1.4.2 is installed (such as D:\Program Files\Java\j2re1.4.2_09), and
open the javaws subfolder.

Run Java Web Start (javaws.exe).

Choose View > Downloaded Applications.

Select the Agile 9.0 application.

Choose File > Preferences.

Click the Java tab.

In the Platform Version column, select 1.6. Make sure the Enabled checkbox is unchecked.
Click OK.

© N o o b~ w DN

Reconfiguring Java Client JNLP Files

When you install the Agile Application Server, the following two JNLP files are configured for the
Agile Java Client. These files are embedded with the application.ear file and deployed with the
application:

o pcclient.jnlp
o extjnlp

A JNLP file is an XML document that describes a Java application to be launched by Java Web
Start. Ordinarily, the JNLP files are configured correctly during installation of Agile PLM. However, if
you have an application server cluster and are unable to start Java Client and download its classes,
you may need to reconfigure the JNLP files to point to the right servers.

Modifying the JNLP Files

In the AGILE_HOME\install\bin folder, Agile provides two utilities for unpacking the JNLP files from
the application.ear file and repacking them again after you've modified them:

Windows Scripts UNIX Scripts

ExtractJNLPFiles.cmd ExtractJNLPFiles.sh
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Windows Scripts UNIX Scripts

RepackIJNLPFiles.cmd RepackIJNLPFiles.sh

To extract and modify the Java Client JNLP files:

1.

2
3.
4

Stop the Web proxy server or load balancer.

Stop the Agile Application Server.

On the application server computer, open a command prompt window.

Run the ExtractINLPFiles script to extract the JNLP files from the application.ear file.
AGILE_HOME\install\bin\ExtractINLPFiles

Important If you have an WebLogic Server cluster, extract the JNLP files only on the
Administration Server. When you redeploy the Agile application, the updated JNLP files will be
propagated to all servers in the cluster.

Open the pcclient.jnlp file in a text editor. The file is located in the
AGILE_HOME\agileDomain\applications folder.

Find the following tags and edit the values listed below:
jnlp:

<jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient">
serverURL:
<argument>serverURL=<protocol>://<appserver/loadbalancer>.<domain>:<port>/
<appserver_virtual_path></argument>
webserverName:
<argument>webserverName=<proxy/loadbalancer>.<domain>:<port></argument>
where

® <protocol> is the protocol used by the application server. Enter t3 for BEA WebLogic
Server.

* <proxy/loadbalancer> is the Web proxy server hostname or the alias for the load balancer
* <domain> is the fully qualified domain name

® <port> is the Web proxy server port or virtual port for the load balancer.

* <appserver_virtual_path> is the Agile Application Server virtual path. The default is “Agile”.
Save the file.

Open the ext.jnlp file in a text editor. The file is located in the WebLogic subfolder beneath the
AGILE_HOME\agileDomain\applications folder.

Find the following tag and edit the values listed below:
jnlp:
<jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient">
where
* <proxy/loadbalancer> is the Web proxy server hostname or the alias for the load balancer

Page - 77



Installing Agile PLM for WebLogic

® <domain> is the fully qualified domain name
* <port> is the Web proxy server port or virtual port for the load balancer.

10. Save the file.

11. Run the RepackJNLPFiles script to repack the JNLP files into the application.ear file.
AGILE_HOME\install\bin\RepackJNLPFiles

12. Start the Agile application Server..

13. Start the Web proxy server or load balancer.

Opening Multiple Java Clients

If you wish to have the ability to open multiple Java Clients on one machine, perform the following
steps before deploying Agile PLM 9.2.2.4 on your application server:

Important Back up the application.ear file before proceeding.

=

On the application server computer, open a command prompt window.
2. Run the ExtractINLPFiles script to extract the JNLP files from the application.ear file.
AGILE_HOME\install\bin\ExtractINLPFiles

Important If you have a WebLogic Server cluster, extract the JNLP files only on the
Administration Server. When you redeploy the Agile application, the updated
JNLP files will be propagated to all servers in the cluster.

3.  Open the pcclient.jnlp file in a text editor. The file is located in the
AGILE_HOME\agileDomain\applications folder.

4.  Find the following tag:
application-desc main-class:
<application-desc main-class="com.agile.ui.pcclient.PCClient">
5. Add the following tag to this class:
<argument>singleSession=no</argument>
6. Save the file.
Run the RepackJNLPFiles script to repack the JNLP files into the application.ear file.
AGILE_HOME\install\bin\RepackJNLPFiles
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Integrating Agile PLM with Oracle AutoVue
19.2¢2

This chapter includes the following:

= Installing Oracle AULOVUE 19.2C2 ......covveueiiveeireeieisistssesees st sss st sasssss s ssnsssessssessanes 79
= Configuring the AutoVue 19.2¢c2 Viewer Client Libraries with the Viewer Installer...........ccococovovrecvncinriennnns 79
= Configuring the AutoVue 19.2¢c2 Viewer Client Libraries Manually ............cccoevvernninninnneinnee s 79

Installing Oracle AutoVue 19.2¢2

To install Oracle AutoVue 19.2c2 (Agile Viewer), you must first download the Oracle AutoVue
19.2c2 Desktop Edition product pack as described in "Obtaining Software from Oracle E-delivery
(on page 13)." Then, follow the instructions in the Oracle AutoVue Electro-Mechanical Professional
Installation and User Guide.

Configuring the AutoVue 19.2¢2 Viewer Client Libraries
with the Viewer Installer

Follow the instructions in the Oracle AutoVue Electro-Mechanical Professional Installation and User
Guide to configure the Viewer client libraries.

Note The following instructions are required ONLY if you are integrating Agile PLM on Solaris
x86 with Oracle AutoVue 19.2c2.

Configuring the AutoVue 19.2¢2 Viewer Client Libraries
Manually

Gathering the Required AutoVue Binaries

1. Copy the html folder from the AGILE_HOME\AVS directory on the Viewer system to a
temporary location.

2. Rename the folder to jVue.

3. Copy the vueServlet.jar file from the AGILE_HOME\AVS\bin directory on the Viewer system to
a temporary location.
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Copy the jVue.jar, jogl.jar, and gluegen-rt.jar files from the AGILE_HOME\AVS\html directory
on the Viewer system to a temporary location.

Copy the com folder from the AGILE_HOME\agileDomain\deployment\tomcat\applet on the
system where the Agile Application Server is installed to the jVue folder previously created.

Configuring the Agile Application Server

1.

7.

Stop the application server.
Delete the Agile deployed folders located at AGILE_HOME\agileDomain\<AppSvrName>

Use the ExtractArchive utility, located in the AGILE_HOME\Install directory, to unpack the
AGILE_HOME\agileDomain\applications\application.ear file.

Add the jVue folder, created in the previous section, to the ExpandedWar directory of the
application.war file, located inside of the application.ear file.

The path should be as follows:
AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWar.

Add the vueservlet.jar, jVue.jar, jogl.jar, and gluegen-rt.jar files,copied in the previous section,
to the \WEB-INF\lib directory of the application.war file's ExpandedWar directory.

Use the RepackArchive utility, located in the AGILE_HOME\install directory, to repack the
application.ear file.

Start the Agile Application server.

Configuring the File Manager

Stop the Tomcat Service.

Delete the deployed folder of your file manager, located at AGILE_ HOME\Tomcat\webapps.
The name of this deployed folder is equivalent to the name of the Virtual Path entered for File
Manager during installation. The default folder name is Filemgr.

Add the jVue folder, created the previous section, to the webfs.war file, located at
AGILE_HOME\agileDomain\applications.

Add the vueServlet.jar, jVue.jar, jogl.jar, and gluegen-rt.jar files copied in the previous section
to the \WEB-INF\lib directory, located inside the
AGILE_HOME\agileDomain\application\webfs.war file.

Set the Agile Viewer Host Name and Port Number in the web.xml file, located inside the
AGILE_HOME\agileDomain\applications\webfs.war at the \WEB-INF\ path.

<servlet-name>VueServlet</servlet-name>
<servlet-class>com.cimmetry.servlet.VueServlet</servlet-class>
<init-param>
<param-name>JVueServer</param-name>

<!--<param-value>hcmweb:5099</param-value>-->
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<param-value>view_server_host hame:port</param-value>
</init-param>
6. Start the File Manager.

7. Check the VueServer Connection on the File Server Configuration page with the following URL:
http://<fileserver_host>:<port>/<fileserver_virtual_path>/Configuration

Note Repeat the steps in this section on ALL File Managers.
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This Appendix includes the following:

Appendix A
Agile PLM Installer Panels

= Common Agile PLM Installer Panels
=  Database Details Panel..............
= Application Server Panels

= Web Server Panels

= Viewer Panels......cccocovvvviinnen.

= File Manager Panels

Common Agile PLM Installer Panels

The following Agile PLM installer panels are common to all components:

Panel

Step(s) to Perform

Welcome

Click Next.

License Agreement

Read the Agile PLM license agreement, and then select | accept the terms of the
license agreement.

Customer Information

Enter your user name and company name.

Choose Install Component(s)

Select the components to install.

When you select each component, a description of it appears in the Description box.

Installation Mode

Select Basic Mode (default) or Advanced Mode installation. Basic mode installs a
standalone application server on Oracle Application Server only with minimal user
input. Advanced Mode allows you to install a standalone or cluster system on Oracle
Application Server or BEA WebLogic.

Installation Location

Enter the directory where you want to install Agile PLM components. This directory is
also referred to as the Agile_Home.

Choose Shortcut Folder

Depending on your operating system, select where you would like to create links or
product icons for Agile PLM. These shortcuts allow you to quickly launch Agile PLM
programs.

Windows users: To create Agile PLM icons for all users, make sure the Create
Icons for All Users box is checked.

Pre-Installation Summary

Review the information you provided in previous panels to make sure it's correct
before you install.

If the information is correct, click Install. If you need to make any changes, click
Previous to go to a previous panel.
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Panel

Step(s) to Perform

Install Complete

You have finished Agile PLM installation.
Click Done to close the installer.

Windows users: Depending on the components you installed, your computer may
restart when you click Done.

Datahase Details Panel

The following Agile PLM installer panel appears to obtain database details:

Panel

Step(s) to Perform

Agile PLM Database Details

Enter your Agile PLM database information. If you do not know these values, see the
database administrator responsible for your Agile PLM database server.

Agile Database Host Name

The fully qualified domain name of the computer where the Agile
PLM database server is installed.

Agile Database Port
For Oracle, the default TNS Listener port is 1521.

Agile Database SID

Enter the Oracle System Identifier that refers to the instance of the
Oracle database running on the server. The default SID is agile9.

Agile Database User

Enter the database user. The default user is agile.

Agile Database User Password

Enter the password for the Agile PLM database user. The default
password is tartan.

Note If your Agile PLM database is configured to use
different values from the defaults listed above,
specify that information instead.

Application Server Panels

The following Agile PLM installer panels appear when you install the Application Server:
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Panel

Step(s) to Perform

Application Server Type

Select the type of application server you are using. Agile PLM supports Oracle
Application Server 10g (10.1.2.0.2) and BEA WebLogic Server 8.1 SP6.

Important The application server you select should be installed
BEFORE you install Agile PLM.

Installation Type

Select Standalone Installation or Cluster Installation.

Note: If you are installing Application Server and File Manager on the same
computer, selecting Cluster Installation will cause both to be clustered.A standalone
installation requires only a single server, and therefore may not be as scalable or as
reliable.

A cluster is a group of servers that work together to provide a more scalable, more
reliable application platform than a single server. A cluster appears to its clients as a
single server, but is actually a group of servers acting as one. A cluster can provide
two key advantages over a single server:

o Scalability: The capacity of a cluster is not limited to a single server or a single
machine. New servers can be added to the cluster dynamically to increase
capacity. If more hardware is needed, a new server on a new machine can be
added.

o High-Availability: A cluster uses the redundancy of multiple servers to insulate
clients from failures. The same service can be provided on multiple servers in the
cluster. If one server fails, the surviving members can continue to serve the
application. The ability to fail over from a failed server to a functioning server
increases the availability of the application to clients.

Server Type

Select the type of server to install, Administration Server or Managed Server. A
typical cluster configuration contains one Administration server and one or more
Managed servers. BEA recommends that all the WebLogic servers should be located
in the same subnet to ensure the multicast messages are reliably transmitted.

Administration Server Details

Enter details for the computer where the BEA WebLogic Administration Server is
installed.

Administration Server Host Name

Enter the fully qualified domain name of the Administration Server.

Administration Server Listen Port

Enter the port number on which Administration Server listens. The
default is 7001. You should accept the default unless you know
that this port is unavailable.
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Panel Step(s) to Perform

Cluster Details Enter the cluster name and the IP multicast address for the Administration server.

Cluster Name
Enter the name of the cluster.

IP Multicast Address

Enter an IP multicast address in the range from 224.0.0.0 to
239.255.255.255 that enables multiple applications to subscribe to
a given IP address and port number and listen for messages.

Note For a successful cluster installation, all the
components of the cluster need to be installed in
the same directory structure on each machine in
the cluster.

Managed Server Information Enter information of one of the Managed Server.

Host Name

Enter the fully qualified domain name (for example,
computername.company.com)

BEA Home Directory Type the location of the BEA WebLogic Server Home Directory, or click Choose to
browse to it.

The BEA Home directory is a repository for common files that are used by multiple
BEA products installed on the same machine.

BEA Product Directory Type the location of the BEA Product Directory, or click Choose to browse to it.

The BEA Product directory is the location where BEA WebLogic Server is installed
(for example, c:\bea\weblogic81).

BEA WebLogic Server Ports Enter WebLogic Server listen ports.
BEA WebLogic Server Listen Port
Enter WebLogic Server listen port. The default port is 7001.

BEA WebLogic Server Secure (SSL) Listen Port
Enter the WebLogic Server secure listen port. The default port is

7002.
Note You should accept the default ports unless you
know they are unavailable.
Windows Service Select whether to run Agile PLM as a Windows service. Choose Yes or No.

Weh Server Panels

The following Agile PLM installer panels appear when you install Agile Proxies:
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Panel Step(s) to Perform

Apache Home Directory Enter the Apache Web Server home directory.

You can click Choose to browse to the Apache home directory.

Note If you are installing Agile PLM on Oracle
Application Server (OAS), DON'T select the home
directory for Oracle HTTP Server, a version of
Apache Web Server that is included with OAS.

Web Server Information Enter information for the Web server used to proxy Agile PLM. If you are using a load
balancer, specify the alias and virtual port for it instead.

Host Name

Enter the fully qualified domain name (for example, computer-
name.company.com) of the Web server. If you are using a load
balancer, specify the alias for the load balancer virtual IP address.

Port Number

Enter the HTTP or HTTPS port used by the Web server. General
Web access is typically available on port 80, but your deployment
may use a different port. If you are using a load balancer, specify
the virtual port number of the load balancer.

Viewer Panels

The following Agile PLM installer panel appears when you install the File Manager:

Panel Step(s) to Perform

Agile Viewer Enter Agile Viewer information.
Host Name

Enter the fully qualified domain name (for example, computer-
name.company.com) of the Viewer.

Port Number

Enter the port used by the Viewer. The default port is 5099, but your
deployment may use a different port if 5099 is not available.
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File Manager Panels

The following Agile PLM installer panels appear when you install File Manager:

Panel

Step(s) to Perform

File Manager User Authentication

A user account is used by the File Manager to communicate with the Application
Server and its peers. You can use the default internal account or create a separate
user account.

Choose the type of user account you want to use for authentication.

File Manager User Account

The File Manager user account is used by the File Manager to communicate with the
Application Server and its peers. The default user account is ifsuser.

File Manager User Name

Enter the user account used to communicate with the Application
Server (default:ifsuser).

File Manager User Password

Enter the File Manager user password (default:agile).

File Manager Storage Location

Enter the directory where the File Manager files are stored. Click Choose to browse
to the path.

Note Make sure the directory you specify is one to which
you have write access. For clustered File
Managers, you must specify a network location.

File Manager Virtual Path

Enter the virtual path used to connect to the Agile File Manager. The default virtual
path is “Filemgr”, but you can change it to something appropriate for your company.

The complete path for your Agile File Manager will be
http://<web_server>:<port>/<file_manager_virtual_path>/AttachmentServlet.

Important: The virtual path for Agile File Manager should be different from the virtual
path for the Agile Application Server, especially if they use the same proxy server.
The virtual paths should also have a different prefix. For example, if the Agile
Application Server Virtual Path is “Agile”, the name of the Agile File Manager Virtual
Path must start with something other than “Agile”.

Agile File Manager

Enter the machine name where File Manager is installed as well as the port number.
Agile File Manager Host Name

Enter the fully qualified domain name of the machine where you are
installing the File Manager.

Agile File Manager Port Number

Enter the port number on which other Agile PLM applications will
connect to the File Manager. The default port is 8080.

If the File Manager is accessed through a proxy server or load balancer, enter the
host name and port number of that machine.

88

Aqgile Product Lifecycle Management




Panel

Step(s) to Perform

Application Server Virtual Path

Enter the virtual path used to connect to the Agile Application Server. The default
virtual path is “Agile”, but you can change it to something appropriate for your
company.

The complete path for your Agile Application Server will be
http://<web_server>:<port>/<appserver_virtual_path>/PLMServlet.

The virtual path for Agile Application Server should be different from the virtual path
for the Agile File Manager, especially if they use the same proxy server.
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Appendix B

Agile Application Server Scripts

This Appendix includes the following:

= |nstallation and Configuration Scripts
= Application Scripts
= File Vault Utilities

Installation and Configuration Scripts

Agile provides several scripts that can be used during installation and configuration of the Agile
Application Server. The scripts are installed into the AGILE_HOME\install\bin directory:

Windows Script

UNIX Script

Description

ExtractArchive.cmd

ExtractArchive.sh

Extracts all of the files in the Agile application.ear file.

ExtractConfigFiles.
cmd

ExtractConfigFiles.s
h

Extracts configuration files from the Agile application.ear file.

ExtractJavaClient-
Files.cmd

ExtractJavaClient-
Files.sh

Extracts all of the Java Client files from the Agile application.ear file.

ExtractJNLPFiles.c
md

ExtractJNLPFiles.sh

Extracts JNLP files for Java Client from the Agile application.ear file.

A JNLP file is an XML document that describes a Java application to be
launched by Java Web Start. To successfully download and install Java Client
using Java Web Start, you must configure the JINLP MIME type for your server.

RepackArchive.cm
d

RepackArchive.sh

Repacks all of the files into the Agile application.ear file. After you run this script,
you are ready to redeploy the Agile application.

RepackConfigFiles.
cmd

RepackConfigFiles.s
h

Repacks configuration files into the Agile application.ear file. After you run this
script, you are ready to redeploy the Agile application.

RepackJavaClient-
Files.cmd

RepackJavaClient-
Files.sh

Repacks all Java Client files into JavaClient.war, and then updates the
JavaClient.war file contained in the Agile application.ear file. After you run this
script, you are ready to redeploy the Agile application.

RepackJNLPFiles.c
md

RepackJNLPFiles.sh

Repacks JNLP files for Java Client into the Agile application.ear file. After you
run this script, you are ready to redeploy the Agile application.

Application Scripts

Agile provides several scripts for deploying and starting the Agile application. The scripts are
installed into the AGILE_HOME\agileDomain\bin directory:
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Windows Script UNIX Script Description

checkLDAPConfig.c | checkLDAPConfig.s Tries to connect to the Directory Server and verify whether LDAP configuration is
md h correct.

encryptpwd.cmd encryptpwd.sh Encrypts a password.

installService.cmd nla Installs Agile PLM as a Windows service.

installServicemana n/a Installs Agile PLM as a Windows service for a BEA WebLogic Managed server.

ged-server.cmd

migrateUsersToDB.
cmd

migrateUsersToDB.s
h

Migrates users from the Directory Server to the Agile PLM database. After you
run this script, make sure to restart your application server.

setEnv.cmd

setEnv.sh

Sets common environment variables used to run other Agile scripts.

startAgile.cmd

startAgile.sh

Starts the Agile application on BEA WebLogic Server.

startAgileCluster.c
md

startAgileCluster.sh

Starts the Agile cluster on BEA WebLogic Server.

stopAgile.cmd

stopAgile.sh

Stops the Agile application on BEA WebLogic Server.

File Vault Utilities

Agile provides several utilities to use with the File Vault. The utilities are installed in the

AGILE_HOME\agileDomain\tools directory.

iFSReorgV2

Used to restructure the file vault during an upgrade from a version prior to Agile PLM 9.2.1.

Usage: java -jar iFSReorgV2.jar -basedir <value> -oldFilePrefix <value> [-newFilePrefix <value>] [-logging
<true/false>] [-simulate <true/false>]

where

o basedir is the file vault location to be reorganized

o oldFilePrefix is the old file name prefix for the existing files in the vault

= newFilePrefix is the new file name prefix. All of the existing files will be renamed with this prefix.
This is an optional argument. If it is not specified, the old file name prefix is used.

@ logging enables logging of warnings or errors if set to true. The log is saved to a file named

ifsReorg.log.

o simulate simulates the reorganization process without actually moving or renaming the files.

MetaFilesRemover

Used to periodically remove metafiles from the file vault based on the last used date or size. This
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utility should be used when upgrading the Agile Viewer.

Note A user-created .cmf file should not be listed or removed from the file vault.

Usage: java -jar MetaFilesRemover.jar [-delete <value>] [-age <value>] [-size <value>] -basedir <value> -
prefix <value> -serverURL <value> -username <value> -password <value>

where

o delete deletes the metafiles.

@ age specifies the last access time (day).

o size specifies file size (KB).

o basediris the file vault location where the metafiles are removed.
o prefix is the file name prefix.

= serverURL is the location of the DMS service, for example,
http://server.company.com:80/Agile/services/DmsService.

@ username is the DMS service username.

o password is the DMS service password.

MetaltemGenerator

Used to generate new metafiles for a file vault and should be used when upgrading Agile PLM or
the Agile Viewer. The utility simulates offline metafile generation from all of the files in the vault and
supports the primary file server, but not structured files.

Usage: java -jar Metaltem.jar -basedir <value> -filePrefix <value> -serverURL <value> -defaultUser <value> -
defaultPassword <value> [-logging <true/false>]

where

o basediris the file vault location where the metafiles are generated.

o filePrefix is the file prefix of the files in the vault.

o serverURL is the URL of the server where the metafiles are persisted.
o defaultUser is the default userid of the Agile system.

o defaultPassword is the password of the default Agile user.

o logging enables logging. All information is saved in the metaltem.log file. By default, logging is
disabled.
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metaUtility

Displays the number of files in the meta generation queue through a graphical user interface.

Usage: java -jar metaUtility.jar
VaultSimulation

Used to create a virtual vault from a database.

Usage: java -jar VaultSimulation.jar -VaultLoc <value> -URL <value> -userid <value> -password <value> [-
prefix <value>]

where

@ VaultLoc is the file vault location.

= URLis the database location.

@ userid is the database userid.

o password is the database password.

= prefix is the file name prefix. The default is Agile.

DeadFilesLocator

Used to locate dead files, including markups, in a file vault and shows how many files are missing in
a specific distributed file management server. Dead files are automatically moved from the file vault
to an archive folder.

Usage: java -jar DeadFilesLocator.jar -attachmentPrefix <value> -vaultRoot <value> [-moveProblemFiles
<Y/N>] [-archiveFileDest <value>] [-db_url <value>] [-db_user <value>] [-db_password <value>] [-file
<value>] [-VERBOSE <true/false>]

where

o attachmentPrefix is the file name prefix.

= vaultRoot is the absolute path of the vault root.

= moveProblemFiles determines the action for the dead files.

= archiveFileDest is the fully qualified path to an existing directory where you want to move the
dead files.

o db_urlis the URL of the database.
= db_user is the name of the database user.
= db_password is the password of the database user.

= fileis the absolute path to the agile.properties file.
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MissingFilesLocator

Used to locate missing files, including redlined files, in a file vault, but not limited to a specific
distributed file management server.

Usage: java -jar MissingFilesLocator.jar -dburl <value> -dbuserid <value> -dbpassword <value> -ifsuser
<value> -ifspassword <value> [-force <value>]

where

m]

u]

u]

dburl is the URL of the database.

dbuserid is the name of the database user.
dbpassword is the password of the database user.
ifsuser is the name of the file vault user
ifspassword is the password of the ifs user.

force forces the utility to continue even if the file server is offline.

FixFileSize

Corrects the file sizes in the database. The file size is determined based on the actual files in the
vault, then corrects the size in the database. If the file size equals zero during an upgrade, the file
size is returned to its original value after running this utility.

Usage: java -jar FixFileSizeUtility.jar -dburl <value> -dbuserid <value> -dbpassword <value> -ifsuser
<value> -ifspassword <value> [-log]

where.

m]

m]

u]

dburl is the URL of the database.

dbuserid is the name of the database user.
dbpassword is the password of the database user.
ifsuser is the name of the file system user.

ifspassword is the password of the file system user.
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Appendix C
Agile System Maintenance

This Appendix includes the following:

USING the SEIVET @S @ CIENT......cuevieiicirsecis sttt
PErfOrMANCE TUNING ..cvviveeieiieisisereei ettt ettt bbbt
Configuring Access to Objects using Agile Administrative Settings
CONFIGUING YOUE FITBWAIL ...ttt ettt bbb bbb
ColOr SEHtiNGS ..cvcvevcveerreeeree e

Checking YOUr TCP/IP CONNECHION .....cvvuevieiieenriercieesreisssesssssessssssesssssessssssssssssssssssssssssssssssssesssssessssssessssesesnes
Configuring Browsers on Client Computers
UNINSEAIING AGIIE PLM ...ttt et

Using the Server as a Client

After installation, test Agile PLM on the server to make sure that client systems can start Agile
products. You may also need to test Agile administration modifications as well. For best results,
apart from this testing, do not use the Agile PLM server to perform data-related tasks such as
creating and modifying Items and Changes.

Performance Tuning

This section provides some information on how to tune the application server to improve the
performance of Agile PLM.

Tuning JVM Parameters

BEA WebLogic Server requires a Java virtual machine (JVM) to run. You can fine-tune your
system’s JVM settings to improve memory management and garbage collection.

The following table provides recommended JVM settings for the Agile Application Server:

Parameter Description Windows UNIX Comments

Xms

Minimum Heap Size

1024m

1024m

The Minimum and Maximum Heap Sizes
should be set to the same value. On Windows,
the maximum value that can be safely set is
1536m. On UNIX, there is often a higher limit,
but the typical recommendation is to have a
heap sized at 2048m.
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Parameter Description Windows UNIX Comments
Xmx Maximum Heap Size 1024m 1024m
XX:MaxPermSiz Maximum space for 256m 256m
e permanent objects
XX:NewSize Initial memory size for 256m 256m
new objects
XX:MaxNewSize | Maximum memory size 256m 256m
for new objects
VMType Hotspot or server hotspot server On Windows, -hotspot option gives the best
results. On UNIX, -server option gives the best
results
Note The Agile PLM installer adjusts JVM parameters to the following values if

available physical memory of the machine exceeds 1.5Gb:

-Xms1024m -Xmx1024m -XX:MaxPermSize=256m -XX:NewSize=256m -XX:MaxNewSize=256m

To modify the JUM parameters on Windows:
1. Shutdown the application server.

2. If the application server is started as a Windows server, perform the following steps:
a. Openthe AGILE_HOME\agileDomain\bin folder.
b. Run the UninstallService.cmd script.
c. Modify the InstallService.cmd file with the appropriate JVM parameters.
d. Run the InstallService.cmd script.

3. If the application server is started from the Start Menu or by using either the startAgile.cmd
script or the startAgileCluster.cmd script, then modify the JVM parameters in those files located
in the AGILE_HOME\agileDomain\bin directory.

Note Edit the startAgileCluster.sh script on each managed server in the cluster.
4. Restart the application server.
To modify the JUM parameters on UNIX:

1. Shut down the application server.

2. If the application server is started with the startAgile.sh script or the startAgileCluster.sh script,
then modify the JVM parameters in those files located in the AGILE_HOME/agileDomain/bin
directory.

Note Edit the startAgileCluster.sh script on each managed server in the cluster.

3. Restart the application server.
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Tuning the Thread Count

On BEA WebLogic Server, the ThreadCount parameter sets the number of simultaneous operations
that can be performed by the Agile application. Agile recommends a ThreadCount value of 35. To
modify the ThreadCount parameter, open the AGILE_HOME\agileDomain\config.xml file.

To set ThreadCount in a standalone environment:

1. Shutdown the application server.

2. Edit the following line in the AGILE_HOME\agileDomain\config.xml file:
<ExecuteQueue Name="default" ThreadCount="35"/>

3. Restart the application server.

To set the ThreadCount in a clustered environment:

1. Shutdown the administration server and all managed servers.

2. Edit the following line in the AGILE_HOME\agileDomain\config.xml file:
<ExecuteQueue Name="default" ThreadCount="35"/>

3. Restart the administration server and all managed servers.

Configuring Access to Objects using Agile Administrative
Settings

Access to Agile objects is controlled through the roles and privileges you grant users using the Agile
web client administrative settings. Before allowing any external access to your Agile servers, you
must first consider who needs access and what they need to access.

The list of potential external users may include, but is not limited to:
@ Contract manufacturers

o Suppliers

@ Customers

o Licensees

o Remote manufacturing facilities

= Field service personnel

= Traveling employees

Allowing access to third-party companies, such as contract manufacturers, may require special
consideration. Most likely, you do not want these users to have access to all of your product
information. Instead, you may want to grant them access to only a small subset of your data. For
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instance, they may need access only to data about products that they build for you.

Agile recommends that you create a role using the Agile Java client administrative settings for each
different type of external user. Once the role is defined, users can be assigned to the role. All users
assigned to the role will inherit the privileges that are assigned to the role.

The Agile Web client administrative settings includes with a role called Example - Subcontractor
that can be used as a template for setting up access for external users. For more information, see
the Agile Administrator Guide.

You can take this one step further, and create a Page Two field on all ltems and Changes called
External User. This field can be filled with any external usernames that are allowed to access each
Item or Change. A privilege can then be created for each role that allows access only to objects
based on the value of this field. For instance, privileges can be created and granted so that Acme
CEM employees can read only objects that have the value Acme in the External User field.

Note In previous releases, there was criteria containing users’ names. If a user's
name no longer exists in the database or if the administrator has changed a
user's name, failure criteria will exist in the agile.log file the first time you start
WebLogic. The invalid query must be modified or deleted before restarting
WebLogic without errors.

Configuring Your Firewall

Most likely, your Agile servers are located behind your corporate firewall. An important part of
system security is allowing incoming connections from the Agile web client to Agile Application
Server and Agile Viewer, while restricting access to other parts of your system.

Color Settings

For best support of the current Agile PLM color-coded user interface, set client computers to display
more than 256 colors.

Checking Your TCP/IP Connection

To verify that the client computer has a TCP/IP connection to the Web server:
1. Opena Command Prompt window.
2. Inthe Command Prompt window, ping the Web server by typing:

ping servername

The system returns a statement similar to the following:
Pinging server_name [10.1.1.160] with 32 bytes of data:

Reply from 10.1.1.160: bytes=32 time =1ms TTL=128

This response verifies that your TCP/IP connection is working.
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Configuring Browsers on Client Computers

Agile recommends that all browsers are set to check for newer versions of stored pages every visit
to the page.

To set Internet Explorer to check for newer versions of stored pages every visit to the page:
1. Open Start > Settings > Control Panel > Internet Options.

2. Onthe General tab of the Internet Properties dialog box, click Settings in the Temporary Internet
files section.

3.  Select Check for newer versions of stored pages: Every visit to the page, then Click OK.

4. Click OK to close the Properties dialog box.

Uninstalling Agile PLM

Follow these instructions to remove Agile PLM.

To remove Agile PLM on Windows:

1. Stop the following services:
® 1IS Admin Service
*  World Wide Web Publishing Service
* AgileService (if you installed the Application Server as a service)
* Tomcat

Note If Trend Micro anti-virus software is running on the same computer where Agile
PLM is installed, stop the Trend Micro service before stopping AgileService.

Uninstall Tomcat, if applicable.
Choose Start > All Programs > Agile > Agile 9.2.2.4 > Uninstall Agile 9.2.2.4.
Click Uninstall on the Uninstall Agile window.

Click Done when finished.

o g > w D

Restart the computer.
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Appendix D
Tuning Memory for Java Applets

This Appendix includes the following:

B JAVA CONIOI PANEL ... 104
= Frequently ASKE QUESTIONS. .......cvireriieeri ettt ettt s 104

The Agile Web Client uses Java applets for advanced functionality. Examples include the Gantt
Chart and the Agile Viewer. These applets use the Java Plug-in to run inside your browser.

The amount of memory an applet requires depends on the content it attempts to load. If you
experience memory problems while running the Gantt Chart, the Agile Viewer, or other Java
applets, you should increase the amount of memory available to Java applets. To configure Java
applet runtime parameters, use the Java Control Panel.

To adjust Java applet runtime parameters on Windows:
1. From the Windows Control Panel, run Java to open the Java Control Panel.
2. Click the Java tab.

3. Inthe Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box
appears.

4. In the Java Runtime Parameters box, add the following:
-Xmx<memory-limit>
For example, to set maximum available memory to 256Mb, enter -Xmx256M.
5. Click OK to close the Java Runtime Settings dialog box.
6. Click OK to close the Java Control Panel.

7. Restart the browser.

To adjust Java applet runtime parameters on UNIX:

1. Determine which version of the Java Plug-in the browser is using.

2. Run the script <java-dir>/jre/bin/ControlPanel to open the Java Control Panel.
3. Click the Java tab.
4

In the Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box
appears.

5. Inthe Java Runtime Parameters box, add the following:
-Xmx<memory-limit>
For example, to set maximum available memory to 256Mb, enter -Xmx256M.
6. Click OK to close the Java Runtime Settings dialog box.
Click OK to close the Java Control Panel.

8. Restart the browser.
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To adjust Java applet runtime parameters on Mac 0S X:
1. Determine which version of the Java Plug-in the browser is using.
2. In Finder, run the Applications > Utilities > Java > Java <java-version> > Plugin Settings command.
3. Inthe Java Runtime Parameters box, add the following:
-Xmx<memory-limit>
For example, to set maximum available memory to 256Mb, enter -Xmx256M.
Click Apply.

Close the control panel, and restart the browser.

o &

Java Control Panel

For more information about the Java Control Panel and how to configure Java runtime settings on
your client computer, go to http://java.sun.com (http://java.sun.com) and search for “Java Control
Panel”.

Frequently Asked Questions

How much physical available memory do | need to run Agile PLM applets?
Please see the Agile PLM Capacity Planning and Deployment Guide for all Agile PLM hardware
and software requirements.

In general, you will need at least 256Mb free available memory to use for Java applets. If the
machine does not have that much memory available, a RAM upgrade is recommended to achieve
the best performance.

On Windows, you can see the free available memory by opening the Windows Task Manager and
clicking the Performance tab.

Do you need Administrator privileges on the client machine to modify Java runtime settings?
It depends on who installed Java on the machine. If the Administrator installed it, only he will have
permission to modify Java runtime settings.

What is the -Xmx Java runtime parameter?
It sets the maximum size of the heap. The default value is 64Mb.

Are there other Java runtime parameters?
Yes, there are several other Java runtime parameters that you can configure. For a complete list,
see the Java Control Panel documentation.
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